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Introduction 
 
This user guide is an introduction to Tax Assistant. You will learn the basics of how to 
start using the main Tax Assistant programs; TaxBase, the Tax Return and the 
Partnership Tax Return modules. 
 
TaxBase  is  a  client  database  management  system  aimed  specifically  at  tax 
applications. You will be able to use the TaxBase client database to store important 
client information. The system also includes a database of HMRC offices and the 
facility to associate each client with the appropriate office. There is also a database 
of UK dividends, which you can edit and extend to your own requirements. This 
dividend information can be imported into Tax Returns, thus saving a large amount 
of manual data entry. 
 
The Tax Return modules provide an on-screen display of the Tax Return and all the 
Supplements.   There   are   also   comprehensive   facilities   for   entering   additional 
information such as bank interest, dividends and pension contribution details. There 
are specialised calculator windows for items such as car benefit, capital allowances, 
profit adjustments, overlap relief and capital gains. The tax calculation, as defined by 
the HMRC, is implemented automatically. You can enter auxiliary information that 
enables an accurate calculation of payments on account due. Client data can be 
automatically imported from TaxBase to the on-screen Tax Return. Information from 
the previous year’s tax return can be rapidly transferred to form the basis of the 
current year’s return. Accounts data produced by many accounts production 
software packages can be imported into the accounts section of the Self- 
employment Supplement.  Data  from  the  partner  statements  in  the  Tax  
Assistant Partnership Tax Return can be imported into the Partnership  Supplement, 
and data produced  using  the  Tax  Assistant  P11D  program  can  be  imported  into   
the Employment Supplement. There is a powerful reporting facility for printing the 
Tax Return, the Supplements, all supporting schedules and the tax calculation. 
 
The  Partnership  Tax  Return  modules  provides  an  on-screen  display  of  the 
Partnership  Tax  Return  and  all  the  Supplements.  Additional information can be 
entered as in the individual   tax return module.  Similarly, client data can be 
automatically imported from TaxBase and the previous year’s partnership return can 
be transferred to form the basis of the current year’s return. Accounts data 
produced by many accounts production software packages can be imported into the 
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accounts section of the Partnership Tax Return.  The reporting facility enables 
printing of the Tax Return, the Supplements, partner statements and all supporting 
schedules. 
  
The Tax Return, Partnership Tax Return, Trust Tax Return and Full Corporation Tax 
Return modules include functions to support Filing By Internet (FBI). FBI is supported 
by means of our Internet communications module called FBI Courier. Use of FBI 
within Tax Assistant is described in the FBI User Guide. 

 
Basic package 
The following modules are included in the basic Tax Assistant package: 
 
TaxBase Tax oriented database management system. 
Tax Return Personal tax returns for all Self Assessment years from 

1997. 
Partnership Tax Return Partnership tax returns for all Self Assessment years 

from 1997. 
CT600 Basic company tax returns for all years from 1999. 

 
Repayment Claim R40 repayment claims for all years from 1997. 
Pensions Planner Pensions planning tool for retirement annuity and 

personal pension relief covering years 1988-89 to 
2009-10. 

 
Options 
The following options are available as enhancements to the basic package: 
 
Company Tax Return Comprehensive Company Tax Return for financial year 

2002 onwards, including all CT600 Supplements, 
computations and supporting schedules. 
 

P11D Preparation of P11D and P11D(b) forms from 2002-03 
onwards, including computations and supporting 
schedules. 

Trust Tax Return Trust and Estate tax returns for all Self Assessment 
years from 1998. 

FBI Courier  
 

Electronic submission of tax returns using Filing By 
Internet (FBI). 
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Tools 

The following “tools” are also provided with all packages: 
 
Library A comprehensive set of essential documents for Tax Assistant   

users,   including   user   guides   and   HMRC notes. 
Data Folder Provides the facility to create and manage multiple data 

folders for storing your Tax Assistant data. 
Licence Control Controls the management of licence activation on your 

computer. 
Purchase/Renew Enables you to select a suitable combination of Tax Assistant 

licences for your organisation, calculate the cost, and produce 
a purchase or renewal order form. 

TA Live Update Provides a facility to automatically update the Tax Assistant   
modules   to   the   latest   versions   over   the Internet. 

 
 
 

Features 

Here are some of the main features of the Tax Assistant: 
 
Windows application, operating within Windows XP, Vista and 7, 32 bit operating 
system. 
Database containing the names, addresses and telephone numbers of HMRC offices. 
 
Database containing dividend data for major UK companies. 
 
Database  for  storing  your  clients'  personal  details  and  information  on  their 
employment, business, assets and pension contributions. 
 
Events diary for tracking tax compliance processing for each client throughout the 
year. A versatile diary reporting system is included. 
 
Label printing facility for tax offices and client names and addresses. 
 
Automatic attachment of names and addresses to standard letters sent to clients 
and tax offices. 
 
Mail merge facility for use with standard word processors. 
 
Facility to produce a form 64-8 for any client, based on information stored in the 
client’s database record. 
 
On-screen display of tax return and supplement forms. 
Supplement Manager for creating appropriate sets of supplements for each tax 
return.  
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Notepad screens for entry of supporting information, such as bank interest, 
dividends and property income. 
 
Calculators for car benefits, capital allowances, profit adjustments, overlap relief and 
capital gains. 
 
Import facility for accounts production data from many standard accounting 
software packages. 
 
Easy-to-use filing system for Tax Return data. 
 
Full integration of data between Tax Assistant modules with data transfer under user 
control. 
 
Intelligent transfer of tax return information from one year to the next. 
  
 
Tax Assistant produces high quality laser printed reports of: 
1) Individual, Partnership and Trust Tax Returns printed on HMRC supplied PDFs.  
2) HMRC approved printed Corporation Tax and Repayment Claim forms. 
3) Supporting schedules for additional information. 
4) Statements of income, deductions, allowances and calculated tax liability. 
 
All printed substitute forms produced with Tax Assistant are HMRC approved. They 
may be submitted as valid returns in place of the “official” versions. 
 
The Tax Assistant software can be run on a standalone PC or within a network. 
 
 

System requirements 
To run Tax Assistant we recommend the following minimum hardware specification. 
The performance of the software depends largely on the capabilities of your 
hardware. The following is an absolute minimum specification. The software will 
perform much better on higher performance systems. 
 
Computer with Pentium processor running at 200MHz. 
32MB of RAM.  
CD-ROM drive. 
Hard disk with 200Mb free. 
Colour SVGA monitor (800 x 600 resolution). Keyboard and mouse. 
A Windows compatible A4 printer capable of printing graphics at 300dpi or better. 
We recommend a minimum of 6ppm and 4Mb of RAM. 
Windows XP, Vista or 7, 32 bit operating system. 
Adobe Reader 8.0 or later. 
 
For electronic  filing  using  Filing  By  Internet  (FBI)  you  will  require  an  Internet 
connection. 
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How to use the programs        
Operating simplicity has been a major consideration in the design of Tax Assistant. 
We are sure that after this introduction to the operation of the programs you will 
quickly become familiar with the system and will soon be producing professional 
quality Tax Returns with a fraction of the effort and time previously required. 
 
We suggest that you follow through the sequence of procedures described in this 
guide, especially in the Tax Return chapter, to familiarise yourself with the basic 
operation of the programs. The best way to learn more details about using the 
system is to experiment with your own client data. There are help screens available 
to guide you through the more complex operations. 
 
In this guide we have assumed that you are familiar with using Windows. Throughout 
this  guide  we  assume  that  you  are  familiar  with  Windows  terminology,  such  as 
“button”,  “click  on”,  “icon”,  “dialogue  box”  and  “text  box”.  If you are not an 
experienced Windows user we recommend that you consult the Windows manuals 
or work your way through the on-line Windows tutorial before using Tax Assistant. 
  
To use our support service effectively you must have a good knowledge of basic 
Windows programs, such as Windows Explorer and Notepad. You must also have 
access to the Internet. This will enable you to download program updates and make 
support enquiries using email and forms on our website. 
 
If you use Tax Assistant in a network environment you must have an understanding 
of basic network concepts such as computer names, shares names and network 
drives. 
 
Follow the installation instructions given in the Installation chapter to install Tax 
Assistant on your hard disk. 
 
Most screens in TaxBase have a Help command button that brings up a description 
of the functions available - use these when required. This user guide takes you 
through all  the  stages  of  setting   up  client  information  in  the  database,  
creating  and manipulating client files in the Tax Return modules, entering 
information into the on- screen Tax Return, calculating tax liability and printing  
reports. Some of the more advanced features are not covered in this guide. Please 
refer to the documents on the individual program modules for more advanced 
information. There are separate user guides that deal with electronic filing. 
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Installation 
Before using Tax Assistant you must make sure that Windows is suitably set up. 
Please read the following two paragraphs carefully before installing the software. 
 
 

Printers 
Make sure your printer is set up to be compatible with the selected printer driver. 
Consult the Windows documentation or Help system if you are not sure how to set 
up the printer driver software and consult your printer documentation to find out 
how to set up your printer. Also, make sure you have the latest printer driver 
software for your printer. New drivers can often be downloaded from a 
manufacturer’s web site. You may have to change the default settings of your printer 
driver software to obtain optimum performance when printing tax return forms. 
These are very different from simple word processor documents and spreadsheets.  
To find the most suitable settings, you may have to experiment with different 
settings. 
 
 

Dates 
Tax Assistant checks for the validity of dates immediately after you enter them. The 
system date format must be dd/mm/yy or dd/mm/yyyy, for example 21/09/03 or 
21/09/2003 for 21st September 2003. You must ensure that the Windows date 
format is set up correctly on your computer. To do this, open the Control Panel 
window then double-click on the Regional Settings icon. Select the Regional Options 
and make sure  the  “Short  date  format”  is  set  to  dd/mm/yy  or  dd/mm/yyyy  
and  the  “Date separator” is / (forward slash). 
 
 

Running the installation program 
Close down all programs before installing Tax Assistant. 
If possible, you should also restart your computer before installing Tax Assistant. This 
will ensure a “clean” installation. 
Insert the CD-ROM into your CD drive. On most computers the setup program will 
start automatically. You may have to wait for a short period to allow the CD drive to 
start reading the CD. If the setup program has not started automatically after about a 
minute, you can start it manually. To do this, run d:\setup.exe, where d: is the CD 
drive letter.  The  setup  program  leads  you  through  each  stage  of  the  
installation process. Click on the Cancel button at any stage to abort the installation. 
  
Tax Assistant Installation 
This is the starting point for installation of Tax Assistant, Tax and FBI Courier. By 
default, Tax Assistant is selected and the check box   labelled “Show instructions 
before installing Tax Assistant” is ticked. This allows you to view and print the release 
notes for the current version of Tax Assistant before proceeding with the installation. 
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If you do not wish to view this document you can turn off this option. With Tax 
Assistant selected, click on the Next button to start the installation process. 
 
Welcome 
The first Tax Assistant screen welcomes you to the installation process. Click on the 
Next button to continue. 
 
Setup Type 
A Typical installation is appropriate for most users. If you are unlikely to require the 
Tax Return modules for 1997 to 2003 you can select a Compact installation and these 
modules will not be installed. A Custom installation can be used if you wish to install 
any of the pre-1997 programs.  You will be given the opportunity later in the 
installation process to select which components you wish to install. 
 
Choose Destination Folder 
The default destination folder is “C:\Program Files\Tax Assistant”, but the setup 
program will attempt to detect a previous Tax Assistant installation on your system 
and offer that folder as the default. It is important that you select the correct folder 
when you are installing future Tax Assistant updates, so we recommend that you use 
the default folder unless there is a good reason not to. If you really do wish to install 
into  a  different  folder,  click  on  the  Browse  button  and  specify  the  appropriate 
directory path. 
 
Select Components 
If you chose Custom as the Setup Type you will be given the opportunity to select 
which software components to install at this time. Scroll through the list and tick the 
boxes for each component you wish to install. 
 
Select Program Folder 
The Program Folder name is the name that will be used in the Windows menu 
system to access the Tax Assistant programs (i.e. the shortcuts). The default folder 
name is “Tax Assistant”. We recommend using this name to ensure that future Tax 
Assistant updates will create shortcuts to the correct folder. If you change this name 
you will have to ensure that the alternative name you use is also used with future 
updates. 
 
Start Copying Files 
Examine  the  “Current  Settings”  to  ensure  that  you  have  entered  the  correct 
information. If you wish to change anything, click on the Back button to return to any 
of the previous steps and make the appropriate changes. When you are satisfied 
with the settings, click on the Next button to start installing Tax Assistant. 
 
Finish 
When Tax Assistant has been successfully installed, the “Finish” screen appears. Click 
on the Finish button to complete the installation. 
  
Restart your computer after installing Tax Assistant. 
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The installation  process  creates  a  shortcut  icon  called  “Tax  Assistant”  on  your 
Windows desktop. Double-click on this icon to open the Tax Assistant Desktop. The 
Tax Assistant Desktop is the normal entry point into the Tax Assistant system. 
 
 
 

Installation on a network 
If you will be using Tax Assistant in a network environment you must install the 
software locally on all the workstations on which the software will be used. In a 
server-based network, such as Windows NT or Netware, you will probably want to 
store your data, such as the client database and the tax return files, in a data folder 
on the network server.  In a peer-to-peer network, such as the Microsoft Windows 
Network, you will probably want to allocate one computer as the file server. In either 
case you will need to set up a data folder on the server and configure each of the Tax 
Assistant programs to access their data from the server. 
 
Firstly, you can use the Data Folder program to create a new Tax Assistant data 
folder on the server. The Data Folder chapter in this booklet gives details of how to 
do this. 
 
You will then be able to use the Data Folder program or the Folder Manager function 
within each of the programs to set up a “pointer” to the Tax Assistant data folder 
you have created. The TaxBase and Tax Return chapters in this booklet give details of 
how to use the Folder Manager function 
 
 
 
 
  

Tax Assistant Desktop 
Open the Tax Assistant Desktop by double-clicking the Tax Assistant icon on the 
Windows Desktop. The Tax Assistant Desktop provides an easy way of starting up Tax 
Assistant programs. 
 
The Tax Assistant Desktop contains command buttons for each of the Tax Assistant 
programs. Click on the appropriate button to run the corresponding program. 
 
The Tax Assistant version number and licence information is displayed at the bottom 
right.  
 
At the bottom of the window there is a status bar showing the full directory path to 
the Tax Assistant Program Folder. When you install Tax Assistant updates you must 
Select this path as the destination folder in which updated programs are to be 
installed. 
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Note:   Program files will often be installed into sub-folders within the main Tax 
Assistant program folder.  When installing updates you should not include the name 
of the sub-folder within the destination path, only the path to the main Tax Assistant 
program folder. 
 
You may find it convenient to minimise the Tax Assistant Desktop window while you 
are running other programs. A check box at the bottom of the screen can be used to 
determine whether or not to automatically minimise the Desktop when you start a 
Tax Assistant program.  
 

 
 
Purchase/Renew 
All Tax Assistant licences are for a period of one year. In order to continue using the 
software you must renew your licence annually. The Purchase/Renew facility enables 
evaluators to produce a Purchase Order form and existing users to produce a 
Renewal Order form. 
 
If you are using Tax Assistant on more than one computer, you only need to use the 
Purchase/Renew function on one computer. 
 
During the final month of your licence period you will be reminded of the imminent 
expiry of your licence each time you run any of the Tax Assistant programs. 
 
To initiate the purchase or renewal process, click on the Purchase/Renew button on 
the Tax Assistant Desktop. This takes you into the Purchase/Renew program. 
 
In the CUSTOMER DETAILS frame, enter all requested information (some boxes are 
mandatory). 
 
In the LICENCE DETAILS frame, a yellow banner shows you the licence period. If you 
are renewing a licence, this banner shows the first and last dates of the new licence 
period. If you are purchasing a licence for the first time this banner reminds you that 
the licence period is one year. 
 
Click on the Package Information button to view a summary of the modules that are 
included in each available package. 
 
It is important that you read the package information summary to determine exactly 
which modules you require. If you have any questions regarding what is included in 
each module, please   contact   our sales department at sales@drummohr.com. 
 
In one of the package frames, enter the number of computers on which you wish to 
run each of the available combinations of modules. 

mailto:sales@drummohr.com


www.drummohr.com 

Getting Started With Tax Assistant 
 

131 

Drummohr is a trading name of Drummohr Technology Ltd which is part of the IRIS Group.  
Drummohr, IRIS and IRIS Flower are trademarks. © Drummohr Technology Ltd 2009. All rights reserved. 

www.drummohr.com 

For example,  if  you  want  to  use  the  basic  Tax  Assistant  package  plus  the  full 
Company Tax  Return, P11D and the Trust Tax Return on one computer, only the 
basic Tax Assistant on a further three computers, enter “1” in the first box, enter “3” 
in the fourth box. 
 
Scroll down if necessary and you will see the licence price in the blue box at the 
bottom of the LICENCE DETAILS frame. You can check the price for alternative 
combinations of modules by changing your entries in the LICENCE DETAILS frame. 
 
When you have selected the package you require, scroll down to the LICENCE 
AGREEMENT frame. Click on the View Licence Agreement button to view and, if 
 
Required, print our Software Licence Agreement. Please read this document 
carefully before proceeding. If you accept the terms and conditions of the Licence 
Agreement, tick the box in the LICENCE AGREEMENT frame to confirm this, then click 
on the Continue button to proceed to the Payment Details window. 
 
In the Payment Details window, select your required method of payment and, if 
applicable enter your credit card details. Click on the Print Purchase Order or Print 
Renewal Order button to print the order form. 
 
All the information you have entered, excluding the payment details, are saved on 
your computer  and retrieved the next time you use the program (e.g. at the next 
renewal date). 
  
 
 
 

Licence Control 
Tax Assistant will only operate in evaluation mode until you have registered your 
licence to use the software. This helps to protect the software from unauthorised 
use. When  your  licence  has  been  registered,  you  can  only  use  Tax  Assistant  on  
the computer on which it was registered until the  expiry date specified in the 
Licence Agreement. If you have purchased a licence to use Tax Assistant on more 
than one computer you may only register the number of computers specified in the 
Licence Agreement. 
 
There is a facility for transferring a licence from one computer to another. To do this, 
you must first cancel the licence on the original computer before requesting a 
licence on the new computer. The licence program that is built into the software 
examines the hardware on your computer to determine a Computer Identity. If you 
intend to alter your hardware (e.g. re-format the hard disk) you must cancel the 
licence prior to doing so, then re-activate it after the alterations have been made. 
This ensures that the current Computer Identity is properly registered. 
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To start the Licence Control program, click on the Licence Control button on the Tax 
Assistant Desktop. This opens the Tax Assistant Licence Control window. Click on the 
Help button to view full details of the Licence Control functions. The Renew button 
(Purchase button if licence not already active on this computer) can be used when 
you wish to renew your annual licence and the Cancel button can be used to initiate 
the transfer of your licence to another computer.  To start the activation process, 
click on the Request button to open the Activation Request window. Enter your 
details in the CUSTOMER frame; the entry in the Identity box is the 6-digit Customer 
Identity you were given when you purchased Tax Assistant. 
 
In the COMPUTER frame, enter a name for this computer in the Name box. If the 
computer is connected to a network, use the computer’s network name; otherwise 
use any name that enables you to uniquely identify this computer. The Identity in the 
COMPUTER frame is generated automatically by the program. Please make sure the 
Date in the COMPUTER frame is the current date; otherwise exit from the program 
and correct the system date on your computer. 
 
The REQUEST frame will be enabled when you have entered all relevant information 
into the CUSTOMER and COMPUTER frames. Tick the boxes to select the modules 
you want to activate on this computer. Make sure you only tick the boxes relating to 
the modules for which you have purchased a licence. Click on the Request button to 
generate an Activation Request code in the green box in the REQUEST frame. 
 
The Print and Save buttons will be enabled when you have generated an Activation 
Request code in the REQUEST frame.  Click on the Print button to print an Activation 
Request form, which you can fax or post to us. Alternatively, click on the Save button 
to save the Activation Request form as a text file, which you can attach to an email 
message. Click on the Exit button to exit from Licence Control. 
 
In response to your Activation Request we will issue an Activation Key. This is a two-
part number, which you must enter into the Licence Control system to activate the 
licence for your selected modules on this computer. When you have received the 
Activation Key, go back into Licence Control and click on the Activate button to open 
the Activate Licence window.  The CUSTOMER and COMPUTER frames should 
contain the same information you entered in the Activation Request window; if not, 
make any necessary corrections.  Also make sure the date in the COMPUTER frame is 
the current date; if not, exit from Licence Control and correct the system date on 
your computer. 
 
The ACTIVATE frame will be enabled when you have completed the CUSTOMER and 
COMPUTER frames. Enter the supplied Activation Key into the ACTIVATE frame then 
click on the Activate button to activate the licence on this computer. 
 
The licence will remain active until the expiry date. The software includes a logging 
mechanism to detect changes of the system date on your computer. You can 
normally make minor changes to correct the date and time.  If you accidentally make 
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a significant date change and find that the computer has become unlicensed, go back 
into the Activation Request window and make a new request. 
  
 
 
 
 

Data Folder 
When you first install Tax Assistant the system selects the program folder as its data 
folder. The data you create (e.g. client database records, tax return files) will be 
stored in sub-folders within the program folder. For example, if your program folder 
is: 
 
C:\Program Files\Tax Assistant 
 
 your client database records will be stored in the file: 
C:\Program Files\Tax Assistant\TaxBase2\Tbase020.mdb  
 
your 2011 Tax Return files will be stored in the sub-folder: 
C:\Program Files\Tax Assistant\Tax11 
 
and your 2011 Partnership Tax Return files will be stored in the sub-folder: 
C:\Program Files\Tax Assistant\Ptx11 
 
There can be advantages in storing your data in a separate folder from the program 
folder. Backing up your data is simpler, and it is easier to transfer your data to a new 
computer. If you are using Tax Assistant in a network, you will probably want to 
store your data in a folder on the network file server so that you can share it with 
other Tax Assistant users on the network. The Data Folder program provides the 
means for creating and updating a Tax Assistant data folder.  It  automatically  
creates  the necessary  sub-folders  and  copies  database  files  from  your  program  
folder.  For example, when a Tax Assistant update installs a new dividends database, 
you can run the Data Folder program to copy the dividends database into the 
TaxBase2 sub-folder within your data folder. 
 
To run  the  Data  Folder  program,  click  on  the  Data  Folder  button  on  the  Tax 
Assistant  Desktop.  There  are  text  boxes  showing  the  full  directory  path  to  the 
program folder and the data folder. The default data folder is “C:\TaxData”. If you 
wish to create a single data folder on a standalone computer you can leave this as 
the selected data folder path. Otherwise, you will have to change the data folder text 
to suit your operating environment. For example, to create a data folder called “TA” 
on a network drive called “F:” you should enter the data folder text as “F:\TA”. You 
can also specify the data folder using a computer name and a share name. For 
example, to set up a data folder called “Tax” within a folder having the share name 
“Data” on a network computer called “Server”, enter the data folder text as 
“\\Server\Data\Tax”. Note that the data folder path you enter is only the directory 
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path to the main Tax Assistant data folder. Do not include any sub-folder names (e.g. 
TaxBase2, Tax11) in the data folder text. The program will automatically create any 
required sub-folders. Instead of typing in the directory path to an existing data folder 
you can use the Browse button to navigate to that folder. 
  
The frame labelled “Select databases to be replaced” contains check boxes that 
allow you to determine whether to overwrite any of the standard databases with 
copies of those contained in the program folder. When you are creating a new data 
folder there are no standard databases currently in the data folder, so you do not 
need to tick any of these check boxes; the standard databases will be copied from 
the program folder into the new data folder. When you have installed a Tax Assistant 
update (e.g. at the beginning of a new tax year), including a new version of the Tax 
Offices database, you will probably wish to update the Tax Offices database in the 
data folder. In this case you should tick the check box labelled “Tax Offices”. Some 
users prefer to edit the Tax Offices database to suit their own requirements and, 
therefore, do not wish to overwrite their existing database with that included in a 
Tax Assistant update. In this case the “Tax Offices” check box should not be ticked. 
 
To create a new data folder or update an existing data folder, click on the Update 
button. A message indicates that the data folder has been successfully set up. If the 
data folder path you entered is invalid or unavailable, an error message is displayed. 
 
If you use multiple data folders (e.g. one data folder for each partner in the firm), 
you will have to repeat the above process for each data folder, entering the 
appropriate data folder text and clicking on the Update button for each data folder. 
 
After you have created a new Tax Assistant data folder you will have to configure 
each Tax Assistant program to access its data in that folder. This can be done using 
the Folder Manager function in each program module, as described in the TaxBase 
and Tax Return chapters of this booklet. Alternatively, you can use the Configure 
function within the Data Folder program. Click on the Configure button to open the 
Configure Programs window. 
 
Decide which programs you want to configure and tick the appropriate boxes in the 
Programs  frame,  or  click  on  the  Select  All  button  if  you  want  to  configure  all 
programs. You will probably want to select all programs when to have installed Tax 
Assistant on a computer for the first time and you want to configure all the programs 
to access their data in a data folder you have created. 
 
Each Tax Assistant module can be configured for rapid access to up to four data 
folders. Each data folder is identified by a name and the directory path to that folder. 
Each time you use the Configure function you can configure one of these four data 
folders for each program module. In the Folder frame, select the number of the data 
folder you want to configure. The directory path you entered in the main Data Folder 
window automatically appears alongside the selected folder number. Enter a name 
by which you will identify this folder in the Name box. If you do not enter a name 
here, the existing name, if any, for that folder number will be retained in each 
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program module. If you want to make the selected folder number the current folder 
in each program module, tick the box labelled “Tick this box to make the folder 
selected above the current folder”. If you do not tick this box, the current folder 
selection for each program module will remain unchanged. 
 
When you are satisfied with all the selections you have made, click on the Configure 
button to configure the selected programs. 
 
WARNING: Do not use the Configure function unless you fully understand the 
process involved in configuring Tax Assistant programs to access data folders. Read 
the Folder Manager sections in the TaxBase and Tax Return chapters in this guide for 
detailed information on configuring individual programs. This will help you to 
understand how the Configure function operates.  If you make a mistake with the 
Configure function your existing Tax Assistant data will not be lost but it may not be 
visible to you until you reconfigure the programs correctly. 
 
You can use the Configure function as often as you like to set up access to different 
Tax Assistant data folders. 
  
 
 
 

TaxBase 
TaxBase is a database management program, designed specifically for tax agents. It 
provides many of the administrative facilities that help to make a professional tax 
practice more productive and efficient. In addition to client information storage and 
retrieval the program includes management  of  databases for dividends and HMRC 
offices, a diary system to record progress of tax  return processing for all clients, 
selective merge facilities based on user defined filter criteria and management of 
standard letters. Data stored in a TaxBase database is easily integrated into the other 
Tax Assistant modules. 
 
Start TaxBase by clicking on the TaxBase button on the Tax Assistant Desktop. You 
will,  firstly,  see  a  banner  screen  that  gives  details  of  the  current  version  of  
the software, your serial number and licence information. After a few seconds the 
banner screen disappears and is replaced by the TaxBase overview screen. Access to 
all information in the database starts from this screen. 
 
Before beginning, take a brief look at the overview screen. This screen has a title bar 
at the top showing the name of the program and the currently selected database, a 
menu bar for accessing all available functions, a toolbar with buttons that provide a 
“single click” method of accessing the available functions, a main display area where 
the data screens will be displayed and, at the bottom of the screen, a status bar. 
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Folder Manager 
TaxBase can operate with multiple databases (e.g. on a network). It includes a facility 
to switch rapidly between different databases. The Folder Manager, accessed from 
the menu bar by selecting Manager... in the File menu, is used to set up the directory 
paths to alternative databases. Any one of up to four TaxBase databases may be 
selected from the File menu. 
 
Note: When referring to your main Tax Assistant program folder in this guide, we 
assume that the software has been installed into the program folder: 
C:\Program Files\Tax Assistant 
 
This is the default installation folder for Tax Assistant from version 7 onwards. If your 
original Tax Assistant installation was earlier than version 7, the default installation 
folder was:  
C:\TAXASS 
 
Keep this in mind when references are made to the “Tax Assistant program folder”. 
All Tax Assistant folders have sub-folders for each program.  For example, the 
TaxBase sub-folder is: 
 C:\Program Files\Tax Assistant\TaxBase2 
 
Directory paths are not case sensitive.  For example the directory path shown above 
could also be specified as: 
C:\PROGRAM FILES\TAX ASSISTANT\TAXBASE2 
 
A typical use of the Folder Manager is to set up a network workstation to access data 
on a network file server. When you install Tax Assistant on a workstation all data is 
accessed, by default, on the local hard drive (normally C:). For example, all your 
client data is stored in the file “TBase020.mdb” in the folder: 
C:\Program Files\Tax Assistant\TaxBase2 
 
To change the configuration to access data on the server drive F, use the following 
procedure: 
 
Go to the File Manager by selecting Manager... in the File menu. 
 
In the first row, you will see the name and folder for the default database. You can 
change the name if you wish, but the default folder cannot be changed at this time 
because this is the currently selected database. 
 
In the second row, enter a name by which you will refer to the database (e.g. 
Network Server) in the left-hand box and enter the full directory path to the TaxBase 
folder on the server (e.g. F:\TaxData\TaxBase2) in the right-hand box. You must 
enter a valid directory  path,  and  it  must   always  end  with  the  TaxBase  sub-
folder  name “TaxBase2”. You would only be able to specify the path 
“F:\TaxData\TaxBase2” if you had previously used the Data Folder program to set up 
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“F:\TaxData” as a Tax Assistant data folder (but see Note below). See the Data Folder 
chapter in this guide for details of how to use the Data Folder program. 
 
Note: You may also specify the directory path to a Tax Assistant program folder 
since a Tax Assistant program folder is also a valid Tax Assistant data folder. For 
example, in a peer-to- peer network, the peer server may also be used as a Tax 
Assistant workstation with the shared data stored in its program folder. This is not 
recommended, however, since it is  preferable  to  keep  data  in  a  separate  folder  
from  the programs. 
 
Click on the OK button. 
 
When you click on the File menu now you will see that there are two databases 
available; 1 - the default database, as before, and 2 - the new database on the 
server. Click on 2 to select the database on the server as the current database. From 
now on the program will use the database on the server, even if you restart the 
program or re- boot your computer. If the menus and the toolbar buttons are 
disabled, it is likely that you are not pointing to a valid data folder. Check that you 
have typed in the directory path correctly, that this is a valid Tax Assistant data 
folder, and that your network has enabled that folder for both reading and writing. 
 
 

Adding, deleting and renaming clients 
Click on the Clients button in the toolbar or select Clients on the Data menu to open 
the Clients window. 
  
To create a new client, click on the New button and enter the client’s first name and 
last name. Every client must have a unique name. If you create a duplicate name the 
program will warn you that it cannot create a client with the same name as one that 
already exists. 
 
Tip: If  you  have  two  clients  with  the  same  name,  change  the spelling of one 
of the names slightly. Even the addition of a single character, such as a period or a 
space at the end of the last name will make it unique. 
 
To change the name of an existing client, select the client in the list and click on the 
Rename button. 
 
To delete a client from the database, select the client in the list and click on the 
Delete button. You will be asked to confirm the deletion before the client is deleted 
from the database. 
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Editing client information 
Use any of the command buttons on the second and third rows of the toolbar or 
select the required item on the Data menu to open a client information window. 
There are Help buttons on some of the screens to give guidance on how data should 
be entered. You can enter information into the text boxes and use the check boxes 
and option buttons to indicate whether specific characteristics apply to the currently 
selected client. To select a client, go to the Clients window and double click on the 
client’s name on the list, or select the client in the list and click on the Select button. 
The following paragraphs describe the main features of each data window. 
 

Personal 

In the "Called" field, enter the name by which you would normally address the client 
in the salutation of a letter. For example, if you would start a letter with "Dear 
John,", enter John in the Called field but if you would start a letter with "Dear Mr. 
Smith", enter Mr. Smith in the Called field. 
In the Spouse section you can either type in the spouse details directly or click on the 
Select button to fill in the fields with data from a previously stored client. 
Use the Indicators button to open one of the Indicators windows - see the paragraph 
below on Indicators. 
 

Administration 

If you know the number of the client's tax office you can enter the number in the 
“Number” field   -   the name, address, telephone number and fax number will 
automatically appear when a valid tax office number is entered. Alternatively, click 
on the Select button to select the tax office from the alphabetic list of tax office 
names. Note that recent changes in tax offices means that more than one tax office 
may have been allocated a specific number by the HMRC. TaxBase requires that all 
offices in the database have a unique number. This means that, while the TaxBase 
office number is nearly always the same as the HMRC number, there are rare 
instances where it is different. If you type in the office number, it must be the 
TaxBase number rather than the HMRC number. The safest approach is to use the 
Select button. 
  

Employment 

Data may be stored for up to four employments. Use the PAGE up and down arrows 
to change from one employment to another. 
The Net Relevant Earnings can be imported into the Tax Assistant Pensions Planner 
module. If you intend to use this facility you must enter the Tax Year in a format such 
as 2008-09 or 2008/09 for the 2008 to 2009 tax year, 2009-10 or 2009/10 for the 
2009 to 2010 tax year, and so on. Use the arrow buttons to move the NRE 
information up and down. 
Use the Indicators button to open one of the Indicators windows - see the paragraph 
below on Indicators. 
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Business 

Data may be stored for up to four businesses. Use the PAGE up and down arrows to 
change from one business to another. 
The Net Relevant Earnings can be imported into the Tax Assistant Pensions Planner 
module. If you intend to use this facility you must enter the Tax Year in a format such 
as 2008-09 or 2008/09 for the 2008 to 2009 tax year, 2009-10 or 2009/10 for the 
2009 to 2010 tax year, and so on. Use the arrow buttons to move the NRE 
information up and down. 
Click on the List button in the Year end frame to open the Year End window. In this 
window, click on one of the month labels to display a list of businesses with a year 
end in that month. To use this facility you must already have a ‘Name of business’ 
entered in the Business window. 
Click on the Print button to print the currently displayed list. 
Click on the Merge button to create a mail merge data file containing the clients on 
the currently selected list – see the paragraph below on Merge. 
Click on the Close button to return to the Business window. 
Use the Indicators button to open one of the Indicators windows - see the paragraph 
below on Indicators. 
 

Assets 

The grey boxes are reserved for descriptions of assets and liabilities common to all 
clients; the white boxes are for descriptions of items specific to the currently 
selected client. Click on the Details buttons to enter more detailed information on 
specific assets or liabilities. If you do not wish to use this window for its normal 
purpose, it is ideal for general information storage and retrieval. It contains labels 
(the grey boxes), dates,   monetary   amounts   and   notes.   There   are   many   
practice   management applications for which this window could be used and, bear in 
mind, that the client database  is  Microsoft  Access  compatible,  so  you  can  create  
merged  reports  in applications  such  as  Microsoft  Word  using  the  data  from  
your  TaxBase  client database. 
 

Pension Contributions 

Use the Help button to display guidance on how to enter information in this window. 
The information entered here will be imported into the Tax Return and Pensions 
Planner modules. Make sure you enter the gross or net payments where 
appropriate. 
 

User Defined 

This window is available for you to use as you wish. You can edit the Title text box to 
provide a label for this window. As you edit the title, the caption on the User Define 
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button  in  the  toolbar  and  the  User  Defined  item  in  the  Data  menu  changes 
accordingly. 
Use the grey boxes to enter data that is common to all clients and the white boxes to 
enter data specific to the currently selected client. The combination of grey and 
white boxes allows you to use the grey boxes for labels and the white boxes for data 
associated with these labels. 
 

Diary 

The Diary is one of the most important elements of TaxBase. Used effectively, it 
provides a powerful administrative tool for handling your client's tax affairs. 
The diary covers any four years. Edit the Tax Year text boxes as required and use the 
up and down arrows to move from one year to another. 
When you have used all four available tax years you can use the tax year selection 
buttons to select the “oldest” tax year, and then use the Clear All button to delete all 
information for that year. You can then edit the Tax Year text for that page and re-
use it for the “new” tax year. Make a backup of you client database file, 
Tbase020.mdb in the TaxBase2 sub-folder within your currently selected  Tax 
Assistant data folder, before  using  the  Clear  All  button,  just  in  case  you  need  to  
re-cover  the  diary information for the “oldest” tax year in the future. 
Each diary  page  comprises  "Standard  Events",  described  in  the  grey  boxes  and 
"Client Events", described in the white boxes. The standard event descriptions apply 
to all clients and the client event descriptions apply only to the currently selected 
client. 
Before using the diary in earnest you will have to decide which standard events are 
important to you and enter them in the standard event descriptions. Typical 
examples of standard events are "Request for data sent to client", "Data received 
from client" and "Tax Return sent to HMRC". 
As each event occurs, enter the date in the appropriate text box. As well as keeping a 
record of when each event occurred you will also be setting up the system for "diary 
filtering" which enables you to produce lists of clients using defined criteria. For 
example, you can create a list of "clients whose tax returns have not yet been 
lodged" or a list of "clients who have been requested to supply tax data but have not 
yet responded". 
The best way to illustrate diary filtering is with a typical example. To follow this 
example you will need a reasonable number of clients in your database. 
Let us assume that you want to produce a list of all clients whose tax returns are 
currently being processed in your office - that is, those whose tax return data for the 
current tax year has been received but whose tax returns have not yet been sent to 
the HMRC. You have created standard events called "Tax Return data received from 
client" and "Tax Return sent to HMRC". As you received each client's tax data you 
would record the fact by entering the date on which it was received alongside "Tax 
Return data received from client" in that client's diary.  Similarly, when a client's tax 
return is sent to the HMRC you would enter the date alongside "Tax Return sent to 
HMRC". 
Click on the List On button to bring up your client list, which will initially show all 
client names.  The column of green boxes at the right side of the standard event 
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descriptions provides the diary filtering facility. In our example we require to know 
which events have a date entered alongside "Tax Return data received from client" 
and no date entered alongside "Tax Return sent to HMRC". Click on the green box 
alongside "Tax Return data received from client" - the letter Y (for Yes) appears in 
the box and the list changes to include all those clients for whom you have entered a 
date in this line. Now click on the green box alongside "Tax Return sent to HMRC" - 
the letter Y appears - click on it again and the letter N (for No) appears. You have 
now specified the required filter criteria and the list shows the clients whose diary 
entries satisfy the criteria. 
At the top of the list there is a text box containing the word "Title". You can replace 
this text with an appropriate title such as "Client data currently being processed". To 
print the list of selected clients, click on the Print button, to create a merge file 
containing this list of clients, click on the Merge button. Note that the caption on the 
"List" button has now changed to List off. Click on this button to turn the list off. 
The above procedure may seem a bit complicated at first but with practice you will 
find that diary filtering is very simple, requiring just a few clicks of the mouse to 
produce a list of  clients satisfying your selected criteria. It does not matter which 
client is selected when you set the filter criteria. 
A Report facility is included in the Diary window. This can be used to produce a 
management report relating to tax return processing for all clients in the database. 
There is also a filtering facility that allows you to qualify a report to be specific to a 
particular partner, manager, and assistant or tax office, using the information stored 
in the Administration window. The report is based on up to six ‘key events’ selected 
from the list of Standard Events. To generate a report, proceed as follows: 

1. Start TaxBase and go to the Diary window. It does not matter which client is 
currently selected. 
 

2. Identify key events by inserting an asterisk as the first character in the event 
description. You can select up to six key events; if you select more than six, 
only the first six will be used. 
 

3. Click on the ‘List On’ button to display the client list. 
 

4. If required, click on any of the green filter boxes to restrict the client list to 
any selected criteria. 

 
5. Edit the list Title box to make it a description of the report. 

 
6. Click the ‘Report’ button to display the Diary Report dialogue. 

 
7. If you wish to restrict the report to clients dealt with by a particular Partner, 

Manager or  Assistant, or those associated with a particular tax office, enter 
the appropriate  text  in  the  ‘Conditional  report  with:’  text  boxes.  If  you  
use  the conditional report facility you must  ensure that the text entered in 
each client’s Administration  window  exactly  matches  the  text   you  enter  
in  any  of  the conditional report boxes. Conditional reporting allows you, for 
example, to specify a report containing “all clients dealt with by partner John 
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Smith and handled by the South Wales Area tax office”. If you leave the 
conditional report boxes blank the report will include all clients in the 
currently displayed list. 

 
8. The report includes a reference number for each client. You can decide which 

reference number is used by selecting one of the options in the ‘Use as 
reference:’ frame. The report will contain the reference number for each 
client as it appears in the Administration window. 
 

9. Click on the ‘Print’ button to preview and print the report. If you have a large 
number of clients there may be some delay in producing the report. While 
the program is creating the report the left panel in the TaxBase status bar 
indicates progress. 

 

Indicators 

The Personal, Employment and Business windows each have buttons that open an 
Indicators window. There is a separate set of indicators for each employment and 
business page, but the indicators need not be associated with the windows from 
which they are accessed.  You  can  enter  any  text  into  the  indicator  descriptions;  
the descriptions are associated with all clients in the  database. Use the check boxes 
to indicate whether or not each indicator applies to the currently selected client and 
the green filter boxes to produce filtered client lists in the same manner as that 
described above for the Diary. 
 
The Print button can be used to print the currently displayed list of clients. The 
Merge button can be used to produce a merge data file for use with word 
processors. The Labels button (available only in the Personal Indicators window) can 
be used to print address labels for the currently displayed list of clients. 
 
For example, you may specify an indicator description called "Living abroad". As you 
enter client data you would tick the check box alongside this indicator for each client 
who is living abroad. When you click on the filter box alongside this indicator a list 
will appear of all clients who are living abroad. You may wish to send a personalised 
document to all clients who are living abroad. To do this, click on the Merge button 
to  produce  the  merge  data  file,  based  on  the  currently  displayed  client  list,  
for merging into an appropriate word processing document. 
 
 

Labels 
You can print address labels on standard Avery 7163 label sheets, using any selected 
set from your client list. 
 
Select Tools --> Labels --> Clients or click on the client labels button on the toolbar to 
open the Client Labels window. Use the Help button and follow the displayed 
procedure to print the labels. 



www.drummohr.com 

Getting Started With Tax Assistant 
 

251 

Drummohr is a trading name of Drummohr Technology Ltd which is part of the IRIS Group.  
Drummohr, IRIS and IRIS Flower are trademarks. © Drummohr Technology Ltd 2009. All rights reserved. 

www.drummohr.com 

 
The Print options frame contains text boxes that allow you to specify the number of 
copies to print and the starting position for printing labels. Avery 7163 sheets 
contain 7 rows of labels in each of 2 columns. If you print batches of labels less than 
14 you may wish to re-use a sheet of label paper beginning at an intermediate row 
and column. The ‘First Row’ and ‘First Column’ boxes allow you to specify where the 
first label will be printed. Note, however, that laser printer manufacturers 
recommend that laser label paper should not be re-used in a laser printer after any 
of the labels have been removed. The exposed backing sheet can damage the 
printer. 
 
The Address frame allows you to select the address from the Personal window or 
from the Business (page 1) window to appear on the labels. 

 
Letters 
You can create the heading for a letter to any selected client, comprising the name, 
address, date and salutation. This heading can be copied to the Windows Clipboard 
for pasting into other Windows applications. There is also a facility to automatically 
open any one of a set of standard letters into which the letter heading can be 
pasted. 
  
Select Tools --> Letter --> Client or click on the client letter button on the toolbar to 
open the Client Letter window. Select a client in the list; the text box shows the 
letter heading as it will appear in the destination document. 
 
The Address frame allows you to select the address from the Personal window or 
from the Business (page 1) window to appear in the letter heading. 
 
If required, you can edit the letter heading text. Click on the Copy button to copy the 
heading to the Clipboard. You can then go into your word processor and paste the 
heading into any document. Alternatively, after you click on the Copy button, click on 
the Standard Letter button to open the Standard Letters window. This window 
comprises a list of standard letter titles with a numbered button (1-9) associated 
with each, and two text boxes that are used to specify the directory path to your 
selected word processor (Microsoft Word or WordPad). 
 
If you want to use Microsoft Word as your word processor, enter the directory path 
to the Microsoft Word application file, WINWORD.EXE, in the box labelled “Word 
folder”. The entry you make in this box will depend on where Microsoft Word has 
been installed on your system. Typically, this entry will be: 
 
C:\Program Files\Microsoft Office\Office\Office14 
 
 
If you want to use WordPad as your word processor, leave the box labelled “Word 
folder”  blank   and  enter  the  directory  path  to  the  WordPad  application  file, 
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WORDPAD.EXE, in the box labelled “WordPad folder”. The entry you make in this box 
will depend on where WordPad has been installed on your system. For Windows XP, 
Vista or 7 the entry will typically be:  
 
C:\Program Files\Windows NT\Accessories 
 
If you do not know where Microsoft Word or WordPad is installed on your system 
you  can  use  the  Windows  Search  function  to  find  the  file  WINWORD.EXE  or 
WORDPAD.EXE. 
 
The entries you make in the “Word folder” and “WordPad folder” will be retained, 
even when you restart your computer. 
 
When the “folder” boxes have been set up, click on a letter button (1-9) to select the 
required standard letter (Note that you can edit the standard letter titles to suit your 
own standard letters). When you click on a standard letter button, Microsoft Word 
or WordPad is started and the selected standard letter is opened. 
 
In your standard letter document, position the cursor where you want to place the 
letter heading and use Edit --> Paste to attach the heading to the letter. Do not to 
save the document when you exit unless you delete the heading before doing so. 
 
 

Merge 
You can create a merge data file for use with any standard word processing package 
such as Microsoft Word. The merge file is a standard delimited text file with the 
names of the merge fields in the first line of the file. You can select the field delimiter 
character and specify whether or not quotation marks are used around the merge 
fields. The choice of delimiter character and use of quotes will depend on which 
application you intend to use the merge data file with. 
 
Select Tools --> Merge --> Clients or click on the client merge button on the toolbar 
to open the Client Merge window. Use the Help button and follow the displayed 
procedure to create the merge file. 
 
The Address frame allows you to select the address from the Personal window or 
from the Business (page 1) window to appear in the merge data file. 
 
The merge data file that is created is called MERGE.TXT. It is saved in the TaxBase2 
sub-folder within the Tax Assistant program folder.  If you have installed Tax 
Assistant in the default folder, therefore, the merge data file will be: 
 
C:\Program Files\Tax Assistant\Taxbase2\Merge.txt 
 
If you use the default delimiter, which is a comma, and have the ‘Use quotes’ check 
box ticked, the  file is created in “comma separated variable” (CSV) format. All 
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commonly available word processors can use such files as their data source for mail 
merge. 
 
 

Print Client Records 
You can create a printout of any selected client database records; either the full 
record or selected parts of it. 
 
Select Tools --> Print --> Client Records or click on the client print button on the 
toolbar to open the Client Records window. Use the Help button and follow the 
displayed procedure to print client database records. 
 
The Print options frame contains check boxes that allow you to select which sections 
of each client record to print. For example, if you never use the Assets window you 
can turn that check box off. 
 
When you have selected which client records you wish to print, click on the Print 
button to print them. 
 
 

Form 64-8 
When you acquire a new client you will probably want to submit a form 64-8, 
authorising your agent, to the HMRC. TaxBase includes a facility to print this form 
using data from the client’s record in the TaxBase database. 
 
Select Tools --> Form 64-8 or click on the 64-8 button on the toolbar to open the 
Form 64-8 window. 
 
Enter your firm’s details in the Agent frame. This information is retained within the 
system and will re-appear each time you open the Form 64-8 window. 
 
Select the required client’s name on the list of clients. That client’s details, as stored 
in your TaxBase database, will appear in the Client frame. You can edit any of the 
information in the Client frame without affecting the data in the client’s database 
record. When you have completed  all information in the Client frame click on the 
Print button to preview and print the form 64-8, or click on the Save button to save 
the form 64-8 as a PDF file, which you can then attach to an email message to send 
to the client for signing. 
 
 

Tax Offices database 
TaxBase  includes  a  database  containing  the  reference  number,  name,  address, 
telephone and fax number of HMRC offices. You can add new records and edit or 
delete existing records. You can also print address labels for selected offices, 
automatically attach HMRC office names and addresses to standard letters and 
create a merge file of selected offices for use in word processors. 
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To access the Tax Offices database, select Tax Offices in the Data menu or click on 
the Tax Offices button on the toolbar to open the Tax Offices window. 
 
Note: The title bar of the Tax Offices window shows the version number of the Tax 
Offices database. We update this database from  time  to  time  and  publish  the  
latest  version  on  our website. You can check whether you have the current version 
and, if necessary, download the latest version from: 
http://www.drummohr.com/download.htm 
 
Click on an office in the list to bring the details of that office into the dialogue area. 
You can edit the information in the dialogue area and the database record will be 
updated accordingly. Normally, you do not need to use the Save button. Use the 
New button to create a new tax office, the Rename button to change the number or 
name of an existing office and the Delete button to delete the currently selected 
office from the database. 
 
If you know the number of an office and wish to locate that office in the list, enter 
the number in the "Goto" text box then click on the Goto button. 
 
Note: Because of HMRC office changes, there a few tax offices that now have the 
same 3-digit reference number. TaxBase requires a unique 3-digit number so, in 
these cases, you will find that the TaxBase reference number is not the same as the 
HMRC office number. When using the Goto function you must use the TaxBase 
reference number rather than the HMRC office number. For the vast majority of 
offices, however, the TaxBase reference number and the HMRC office number are 
the same. 
 
The Labels, Letter and Merge functions operate in the same way for tax offices as 
they do for clients. For the Letter function you can display a list of Tax Offices or 
Clients using the option buttons. When you select a client from the list, the client's 
tax office, as specified in his or her Administration window, appears in the letter 
heading text box along with the client's name and tax reference. If no tax office has 
been specified in the Administration window the letter heading text box remains 
blank. Refer  to  the  section  on  client  letters  above  for  details  on  using  the  
Copy  and Standard Letter buttons. 
 
 

Dividends Database 
TaxBase includes a database of dividends from UK companies. This database has 
been  pre-loaded  with  a  set  of  dividends  that  will  probably  cover  many  of  the 
dividends held by your clients. The database may, however, be edited or extended to 
your own requirements. 
 
Select Dividends on the Data menu or click on the Dividends button on the toolbar to 
open the Dividends Database window. Select the tax year using the option buttons in 
the Tax Year frame.  Select a company name in the list to bring the details of that 

http://www.drummohr.com/download.htm
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company's dividends into the dialogue area. You can edit the information in the 
dialogue area and the database record will be updated accordingly. Use the New 
button to create a new company, the Rename button to change the name or share 
description for an existing company and the Delete button to delete the currently 
selected company from the database. 
 
Note:  The Number boxes are reserved for the sequence number of the dividend. In 
the standard database this field is left blank, but you may enter the sequence 
number here if you wish. Do not use the Number boxes for entering the number of 
shares held by a client - this is done within the Tax Return modules. 
 
 

Linking to other programs 
Information in a TaxBase database can be used by other Tax Assistant programs. You 
can set up client records in TaxBase then import that information, where 
appropriate, into other Tax Assistant programs.  You have complete control over this 
import process.  In the Tax Return chapter of this guide you will learn how to import 
client information from a TaxBase database into the Tax Return. 

  
 
 
 

Tax Return 
The Tax Return modules provide the facilities to create personal Tax Returns for all 
Self Assessment years. In addition to the Tax Return and supplementary pages, these 
modules can be used to produce supporting schedules and tax calculations. There 
are various  additional  functions,  such   as  business  calculations,  capital  allowance 
computations,  capital  gains  calculations,  tax  return   summaries  and  information 
request schedules. Electronic filing, Filing By Internet (FBI) is fully supported. 
 
There is a separate program for each tax year. In this chapter we will refer to the 
2011 Tax Return.  Most  of  the  features  described  here  also  apply  to  the  Tax  
Return programs for other tax years. 
 
Start the 2011 Tax Return by clicking on the 2011 Tax Return button on the Tax 
Assistant Desktop. You will, firstly, see a banner screen that gives details of the 
current version of the software, your serial number and licence information. After a 
few seconds the banner screen disappears and is replaced by the Tax Return 
overview screen. Access to all tax forms starts from this screen. 
 
Before beginning,  take  a  look  at  the  overview  window  for  a  few  minutes.  This 
window has a title bar at the top showing the name of the program and the name of 
the current folder, a menu bar for accessing all available functions, a toolbar with 
buttons which provide an alternative way of accessing these functions, a main 
display area where the tax forms, notepads and dialogues will be displayed and, at 
the bottom of the screen, a status bar. 
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The Tax Return program is designed around the HMRC's Self Assessment 
documentation. To use the program effectively you must have a good knowledge of 
the layout of the Tax Return and supplementary Pages. You should also be familiar 
with the HMRC help notes for Self Assessment. These are available in paper form  
from  the  Inland  Revenue  and  may  also  be  downloaded  from  the  HMRC’s web-
site.  
 
Rather than give a detailed analysis of each aspect of the Tax Return program we will 
use two examples to illustrate its use. You may then experiment with your own client 
data. In the first example we will create a tax return from scratch for an employed 
person with car benefits and some investment income. We will then look at a more 
complex case of a self-employed person who is also a member of a partnership. In 
this example we will show how the "skeleton" of the tax return can be created from 
data previously stored in a TaxBase client database. 
 
Following the examples, there is a more detailed description of some of the more 
complex features of the Tax Return program. 
  
 

Example 1 - Employed taxpayer 
The client in our first example is Mr. John Smith. 
 
Select New in the File menu or click on the New File button on the toolbar to open 
the New File dialogue box. There are three alternative ways of creating a new tax 
return file. These are shown in the frame labelled Select an option for creating the 
new file. The following options are available: 
 
1.  Start with a completely new (blank) file. 
If this is the first tax return you have done for a client and you do not want to use 
data from a TaxBase database within the tax return, use this option to create a basic, 
blank tax return with no supplements. 
 
2.  Include data from a TaxBase database. 
If this is the first tax return you have done for a client and you have a record for this 
client in a TaxBase database, select this option. When the tax return is created you 
will immediately be given the opportunity to import data from the database. 
 
3.  Transfer a file from the previous year. 
If you have already completed a tax return for this client for the previous year, select 
this option. You will be given the opportunity to create the new file based on the 
information in the previous year’s return. Where appropriate, supplementary pages 
will be created automatically and supporting information such as names of bank 
accounts and share holdings will automatically be included on the new return. 
 
In the next example we will illustrate how to create a new return using information 
from a TaxBase database. For the current example, we will create a completely new, 
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blank return. Select the first option if it is not already selected, enter “Smith, John” in 
the New File Name box then click on the OK button or press the Enter key. A new tax 
return is created and page 1 of the Tax Return form appears. 
 
Enter the client’s name and address by typing them into the Taxpayer section at the 
top of page 1 (use the Tab key to move from one box to the next). You could also 
complete the HMRC Office section by typing in the appropriate details. There is, 
however, a quicker method of doing this. Click on the database icon at the top left of 
the HMRC Office section to display a list of all the tax offices, as stored in your 
TaxBase database. Select an office on the list and click on the OK button. The name, 
address, telephone number and office number of the selected tax office are copied 
to the appropriate boxes on page 1 of the Tax Return form. 
 
Click on the TR2 button to view page 2 of the Tax Return. Scroll down the page and 
note that none of the YES boxes are currently ticked, indicating that there are 
currently no supplements.  Before completing the Tax Return form you should 
complete any required supplements. In this example, we will create an Employment 
supplement.  Select  Supplement  Manager  on  the  Form  menu,  or  click  on  the 
Supplement Manager button on the toolbar, or click on the Supplement Manager 
button near the top of page 2 of the Tax Return form to open the Supplement 
Manager window. Currently, there are no supplements listed. Click on the New 
button to open the New   Supplement dialogue box.  You are going to create an 
Employment supplement, so enter a name in the Supplement Name box that will 
identify the supplement. The name of the employer would normally be used for an 
Employment supplement,  but  you  can  use  any  name  that  uniquely  identifies  
the  supplement. 
  
Naming  supplements  is  useful  because  you  may  have  clients  with  multiple 
employments, businesses, etc. and the name enable you to differentiate between 
them. Click on the EMPLOYMENT option in the Supplement frame then click on the 
OK button to create the supplement, which then appears in the list. You can repeat 
the process of creating new supplements to build up a full set of supplements for any 
tax return.  
 
Before filling in the supplements we will make sure the file is saved on disk. Click on 
the Close button to close the Supplement Manager then select Save in the File menu, 
or click on the Save File button on the toolbar.  
 
Open the Supplement Manager again by clicking on the Supplement Manager button 
on the toolbar. Double-click on the EMPLOYMENT supplement in the list to open it. 
Fill in boxes 4 to 8 with the employment details. Enter a payment of 
£35336.00 in box 1 and tax deducted £9385.26 in box 2. Scroll down to the bottom 
of page 1. John Smith has a company car, which he changed during the tax year. To 
calculate his car and fuel benefit click on the calculator icon adjacent to boxes 9 and 
10 to open the Car Benefit Calculator. 
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The Car Benefit Calculator enables you to calculate car benefit and fuel benefit for up 
to 6 cars used in the tax year. You can select the calculation for each car using the 
Select car buttons at the bottom left corner of the calculator window. 
 
With car 1 selected, enter the following:  
 
In the Car details frame: 
Make: BMW Model: 318TDS 
Engine size: 1665 
Type of fuel: D – Diesel 
CO2 emissions: 168 
Date first registered: 01/01/2000 
 
In the Availability frame: 
Date first available: 06/04/2010 
Date last available: 31/12/2010 
 
In the Price of the car frame: 
Total list price (A): 16550.00 
 
In the Car fuel benefit frame: 
Tick the box for “fuel was provided” 
 
Scroll down to the bottom of the window. You will notice that the other relevant 
boxes have been calculated for you. The car benefit for this car appears in box W and 
the fuel benefit for this car appears in box CC. 
 
Click on the >>> button to select car 2. Scroll back to the top of the window and 
enter the following: 
 
In the Car details frame: 
Make: Mercedes 
Model: C240 
Engine size: 2397 
Type of fuel: P - Petrol 
CO2 emissions: 250 
Date first registered: 15/12/2002 
 
In the Availability frame: 
Date first available: 01/01/2011 
Date last available: 05/04/2011 
 
In the Price of the car frame:  
Total list price (A): 22950.00 
Price of accessories (B): 562.00 
Capital contribution (D): 1000.00 
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In the Car benefit frame: 
Private use payment (V): 300.00 
 
The car benefit for this car appears in box W and the total car and fuel benefit for 
both cars appear in the yellow boxes, 9 and 10, in the TOTALS frame. 
Click on the OK button to record the data you have entered and close the Car Benefit 
window. Notice that boxes 9 and 10 have been automatically filled in with the totals 
from the Car Benefit Calculator. If you have entered the data as above box 9 will 
contain £4,810 and box 10 will contain £3,328. 
 
Click on the Save File button on the toolbar to make sure the data you have just 
entered is saved in the client’s file. 
 
Click on the Tax Return button on the toolbar to return to page 1 of the Tax Return 
form. Click on the PAGE 2 button to move to page 2 of the Tax Return form and note 
that  the  YES  box  is  now   ticked  for  EMPLOYMENT;  this  has  been  done 
automatically when you created the Employment supplement. 
 
Click on the Tax Return button on the toolbar to go back to the Tax Return form. Go 
to page 3 and click on the notepad icon next to box 1 to open the notepad for Taxed 
UK Interest. Enter the following: 
 
Bank, building society etc. Interest Tax Gross 
Bank of Scotland, A/c 12345678 325.81 81.45 407.26 
Lloyds TSB, A/c 987654 188.32 47.08 235.40 
TOTALS 514.13 128.53 642.66 
 
When you enter the amount of net interest the tax and gross amounts for that row 
and the totals are automatically calculated. Click on the OK button to transfer the 
totals to the Tax Return and click on the Save File button on the toolbar to save the 
file to disk. 
 
Scroll down to the Dividends section on page 3 and click on the notepad icon next to 
box 3 to open the Dividends from UK Companies notepad. You can enter dividend 
information directly into the dialogue area but, at this point, we will illustrate the 
method of importing dividend data from the TaxBase dividends database. Click on 
the Import button to bring up a list of companies for whom dividends are stored in 
the database. Select ‘BG Group PLC’ and click on the OK button to transfer the 
dividend rates to the dialogue area of the dividends notepad. In the Holding column, 
enter 10000 for each dividend.  The system calculates the dividend and tax credit 
automatically, although you can change them if you wish. Click on the Write button 
to record the dividends in the list. You can recover the dividend information later if 
you wish to edit it by selecting the company in the list and clicking on the Read 
button. Select a blank entry in the companies list by clicking immediately below the 
entry you have just made. Make sure the dialogue area is blank by clicking on the 
Clear button if necessary. Click on the Import button and repeat the above process 
to import the dividend rates for Mothercare PLC. Enter a holding of 1500 for the first 
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dividend and 1000 for the second and click on the Write button to record the 
dividends and update the totals. Click on the OK button to transfer the total 
dividend, tax and gross amounts to the tax return. Box 3 should contain £364.30 
 
Go to page 4 of the Tax Return form. Enter 2500.00 in box 1, enter 500.00 in box 5. 
You could use the Notepad adjacent to box 5 to enter details of Gift Aid payments, 
particularly if there was more than one item, but this illustrates that you can also 
enter information directly on to the on-screen tax forms.  
 
Click on the TCS1 button to go to page 1 of the Tax Return Calculation pages. We are 
now about to perform the tax calculation but, before doing so, click on the File Save 
button on the toolbar to ensure that the data entered so far has been saved. Click on 
the Summary button, or click on the Tax Calculation button on the toolbar to open 
the Tax Calculation window. 
 
Having completed the Tax Return you can now print it. Click on the Print button on 
the toolbar or select Print in the File menu to open the Tax Return Reports window. 
The check boxes in the Tax Return frame allow you to select which pages of the Tax 
Return form you wish to print. You can select which supplements you wish to print 
by clicking on individual items in the list of Supplements or click on the All 
Supplements check box to print all the Supplements. Use the check boxes in the 
Schedules frame to select which schedules you wish to print. You can print a 
summary (SA302). Using the check  boxes  in  the  Outline  frame  you  can  print  a  
Tax  Return  Summary and an Information Request schedule. The Tax Return 
Summary is a concise summary of all information on the Tax Return, supplements 
and schedules. The Information Request schedule is an outline of the contents of this 
Tax Return, which can be sent to the client when requesting information for 
inclusion on the following year’s tax return. 
 
Click on the Preview button to preview the printout on screen before printing it. This 
is particularly useful when printing the schedules. You can determine which pages 
you wish to print, so in a large return with, for example, several pages of dividends 
you can select printing of individual pages. This also applies to the Tax Return and 
supplements, but you can also print any Supplement by clicking on the Print button 
at the bottom of the tax form window while that page is displayed. 
 
Several print options are available. Refer to the Print Settings paragraph at the end 
of this chapter for details. 
 
Finally, select Close in the File menu or click on the Close File button on the toolbar 
to close John Smith’s file. Click on the Yes button in the Close File dialogue to make 
sure the completed file is saved to disc. 
  
 

Example 2 - Self-Employed taxpayer 
In this example we will produce a tax return for Mr. A. Sample, a client whose data 
was supplied as an example in the TaxBase database. We will illustrate how to 
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import data from TaxBase to create the skeleton of Mr. Sample's tax return. We will 
also illustrate how to prepare multiple self-employment supplements based on data 
from the client's business accounts and compute the taxable profit and Class 4 NIC. If 
much of your tax work is based on dealing with clients with similar circumstances to 
Mr. Sample, we suggest you work through this example carefully. 
 
Go back to the 2011 Tax Return program. Click on the New File button on the 
toolbar. Select the option Include data from a TaxBase database and enter the New 
File Name as “Sample, A”.  Click on the OK button to create the new file. Shortly after 
page 1 of the Tax Return form appears the Import TaxBase data window opens 
automatically. 
 
Note:  You can also open the Import TaxBase data window by clicking on the 
database icon in the Taxpayer section on page 1 of the Tax Return form. 
 
The Import TaxBase data window has a list of all client entries in the currently 
selected client database. Select Sample, A. in the list and click on the OK button. You 
are returned to page 1 of the Tax Return form, but the taxpayer and tax office 
information has now been filled in with the data from Mr. Sample's record in the 
database. 
 
Click on the Supplement Manager button on the toolbar to open the Supplement 
Manager. A self-employment supplement and two partnership supplements have 
been created from information in Mr. Sample's business record in the TaxBase 
database. 
 
Notice that, in the list of Supplements, each name has the suffix (0). We call each of 
these a primary supplement. Mr. Sample's main business is his self-employment (AJS 
Designs). There are two accounting periods to be used in computing the 2010- 
11 taxable profit for AJS Designs. To submit supplements for both accounting periods 
we must create an additional supplement for this business. To do this, select AJS 
Designs (0) in the Supplement list then click on the Copy button. This produces 
another Supplement for this business, which we call a secondary supplement. Note 
that the secondary supplement is suffixed by (1) to differentiate it from the primary 
supplement. 
 
To calculate  the  adjusted  profits  correctly  it  is  important  that  the  primary 
supplement is  used for the most recent accounting period and the secondary 
supplement is used for the earlier accounting period. 
 
In this example there is a permanent change of accounting date. Mr. Sample has 
been making up his accounts to 30 April each year but decided to change accounting 
date to 31 July. In this example we allocate the supplements as follows: 
 
Supplement Accounting period 
Secondary (1) 01/05/2009 - 30/04/2010 
Primary (0) 01/05/2010 - 31/07/2011 
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Double-click on AJS Designs (1) to open the secondary supplement. Note that the 
name, description and address of the business have already been filled in with data 
imported from the database. Note also that boxes 5 to 7 & 10 to 13 are blue 
“locked” boxes. These boxes will contain the same information on both the primary 
and secondary supplements, and they can   only   be changed on the primary 
supplement. Enter 01/05/2009 in box 8 and 30/04/2010 in box 9; enter some 
amounts in boxes 14 to 61 so that there is a profit of 12000 in box 63. 
 
Click on the Supplement Manager button on the toolbar then double-click on AJS 
Designs (0) to open the primary supplement.  Enter 01/05/2010 in box 8 and 
31/07/2011 in box 9. Tick box 10 to indicate a change of accounting date. Go to page 
2 and enter some amounts in boxes 14 to 61 so that there is a profit of 3000 in box 
61. Click on the SEF4 button to go to page 4 of the primary supplement. Enter 3400 
as overlap profit brought forward. 
 
Click on the calculator icon next to boxes 65 and 66 to open the Business Calculator. 
Enter the 2009-10 basis period as 01/05/2008-30/04/2009 and 340 in the Period 
(days) box for the number of days of overlap brought forward. 
 
Note: If you had used Tax Assistant to complete Mr. Sample’s 2010 Tax 
Return and used the Transfer function to create the skeleton of his 
2011  Tax  Return,  the  2009-10  basis  period,  overlap  profit  and overlap days 
would have been automatically filled in for you when the 2010 file was transferred to 
2011. Normally, it will only be necessary to fill in these boxes for the first return you 
complete for a client.  The information will be carried forward automatically to future 
years. 
 
Click on the Update button to calculate the 2010-11 basis period, and the amounts of 
adjustment and overlap profit. 
 
Click on the OK button to transfer the calculated dates and amounts to the 
appropriate boxes on the supplement. You will see that the basis period (boxes 65 
and 66), adjustment (box 67), overlap relief used (box 68), overlap profit carried 
forward (box  69)  and  net  profit  (box  72)  have  been  filled  in  automatically  with  
the calculated information. 
 
Click on the Tax Calculation button on the toolbar to open the Tax Calculation 
window. Click on the Summary button. This summary of the tax calculation is in the 
same format as the HMRC SA302 form. 
 
Return to the Tax Calculation page and enter 500.00 in each box for payments made 
on 31 January 2011 and 31 July 2011. Click on the SA302 button to show that Mr. 
Sample will have to make two payments on account for 2011-12; one of £1,864.96 
on 31 January 2012, and the other of £1,864.96 on 31 July 2012. His total payment 
due on 31 January 2012 is £4,594.88. 
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Close the tax calculation summary page. Go to page TCS1 of the Tax Return form. 
You will see that boxes 1 and 4 have been automatically filled in with the appropriate 
amounts. 
 
You can now print the Tax Return, as in the first example, but make sure you save 
the file first. 
  
 

Folder Manager 
The Tax Return program has the ability to operate with multiple client file folders 
(e.g. on a network) and enables you to switch rapidly between them. The Folder 
Manager, accessed from the menu bar using File --> Folder --> Manager..., is used to 
set up the directory paths to alternative folders. Any one of up to four folders may 
be selected from the File menu. 
 
A typical use of the Folder Manager is to set up a network workstation to access files 
on a network file server. When you install Tax Assistant on a workstation all Tax 
Return files are accessed, by default, on the local hard drive (normally C:). The 2011 
individual Tax Returns are stored in files named Clixxx.fil in the folder “C:\Program 
Files\Tax Assistant\Tax11” (where xxx is a 3-digit   number and “C:\Program Files\Tax 
Assistant” is your Tax Assistant program folder). There is an index file, Clientid.txr, in 
the same folder. This file is used to identify which file is used to store each client’s 
tax return. To change the configuration to access data on the server drive F:, use the 
following procedure: 
 
Go to the Folder Manager using File --> Folder --> Manager. 
 
In the first row, you will see the Folder Name and Directory Path of the default 
folder. You can change the Folder Name if you wish, but the Directory Path cannot be 
changed because it is the currently selected folder. 
 
In the second row, enter a name by which you will refer to the data folder on the 
server (e.g. “Network Server”) in the left-hand box and enter the full directory path 
to the folder on the server (e.g. F:\TaxData\Tax11) in the right-box. 
 
Important:   The  last  part  of  the  directory  path  (\Tax11  in  the  example above) 
must be the same for all folders used by this program. Personal tax return data is 
always stored in a sub-folder TaxYY (where YY identifies the tax year; 00 for 1999-00, 
01 for 2000-01, 02 for 2001-02, 03 for 2002-03, and so on). Thus for the 
2010-11 tax year the sub-folders are Tax11 for the Tax Return, Ptx11 for the 
Partnership Tax Return, Ttr11 for the Trust Tax Return, R4011  for the Repayment 
Claim,  Ctr11  for  the Company Tax Return and P1111 for the P11D. 
 
Click on the OK button to update the Folder Manager information. Now, when you 
select File --> Folder, you will see that there are two client file folders available; (1) 
the default folder as before and, (2) the new folder on the server. Click on (2) to 
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access the folder on the server. From now on the program will automatically use the 
folder on the server. 
 
Using the above procedure you can set up sixteen separate data folders and switch 
rapidly between them by selecting them on the File menu. 
 
Please refer to the Data Folder chapter in this guide for further details about creating 
and configuring Tax Assistant data folders. 
 
 

Dividends Notepads 
The Tax Return program includes dividends notepads, which are accessed from page 
3 of the Tax Return.  TaxBase includes a database of dividends for major UK 
securities. You can customise this database to suit your own requirements by adding 
to it or editing existing information. The information in the dividends database can 
be imported into a Tax Return file. In this section we describe how to perform this 
process within the Tax Return module. For further details of the Dividends Database 
refer to the TaxBase chapter in this guide. 
 
The dividends notepads are accessed from the on-screen Tax Return form by clicking 
on notepad icons on page 3. Each notepad has the following items: 
 
1) Dialogue area for data entry 
2) List of stored securities 
3) Command buttons 
 
If you wish, you can type all data into the text boxes in the dialogue area. There are, 
however, several shortcuts that will speed up the process. Proper use of the 
command buttons will significantly enhance your use of the dividends notepads. The 
following is a brief description of the function of each command button. 
 
Clear Clears the dialogue area. Note that the stored data is not erased and can 

be recalled using the Read button. 
 

Read Reads stored data for the currently selected security and displays it for 
editing in the dialogue area. 

Write Writes  the  contents  of  the  dialogue  area  into  the  currently  selected 
position in the securities list. If the currently selected entry is not blank 
you are given the opportunity to abandon the Write operation before the 
current data is overwritten. 
 

Insert Creates  a  blank  space  in  the  securities  list  immediately  above  the 
currently selected security and selects that position in the list. 
 

Delete Deletes the currently selected item from the securities list.  All data 
associated with that security is erased. 
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Import Copies the dividend information from the dividends database into the 
dialogue area. If the Name of company and Description of shares already 
contains information that matches exactly an entry in the database, the 
dialogue area is updated automatically. Otherwise you are presented 
with a list of the securities stored in the database and you may select the 
appropriate security from the list. 
 

Update Copies dividend information from the dividends database for all items in 
the securities list that match exactly a Name of company and Description 
of shares as they appear in the database. 

 
The method  of  using  the  Import  and  Update  buttons  may  not  be  immediately 
obvious. The following explanation will help you understand their use. 
  
The Import function can be used to set up a new dividend entry in the dialogue area. 
To  do  this,  make  sure  the  dialogue  area  is  blank  (click  on  the  Clear  button  if 
necessary). Click on the Import button, select the required security from the list of 
entries in the database and click on the OK button to perform the Import function. 
You  will  see  that  the  security  name  and  description  have  been  copied  into  the 
dialogue area along with the dividend dates and rates. You may now type the 
amount of the client’s holding into the appropriate text boxes. The dividend and tax 
credit information will be automatically updated. It is still possible to edit that data if 
you wish. Click on the Write button to store the data in the client’s dividend list. 
 
The Import function can also be used to update the dialogue area for securities 
whose information has been transferred from a previous year. To do this, select the 
required security in the list and click on Read to bring the information into the 
dialogue area. You will see that, at this stage, only the Name of company, Description 
of shares and Holding have been transferred from the previous year. Click on the 
Import button - if the Name of company and Description of shares match exactly 
those stored in the dividends database the dialogue area will be updated 
automatically, otherwise you will have to select the security from the list of those 
available in the database. Click on the Write button to store the data in the client’s 
dividend list. Note that when the Import function has been performed once, the 
Name of company and Description of shares match and you will not have to select an 
item from the database list when you use the Import function on this particular 
security on future occasions (e.g. in future years). 
 
The Update function automatically performs the Import function on all items in the 
securities list in a single step. The Update function will only be of real value when all 
items in the securities list match those in the dividends database. It will therefore be 
of most value in future years, or if you have used the dividends database in the 
previous year’s tax return and used the Transfer File function to create the current 
year’s tax return file. When your securities list for each client matches those in the 
dividends database the Update function provides an immensely powerful facility for 
rapidly updating all dividend entries with a single click of the mouse. 
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Capital Allowances Notepads 
The Capital Allowances notepads can be accessed from the Self-employment 
supplement in the individual Tax Return, and from the main Partnership Tax Return 
or any Trading and Professional Income supplement in the Partnership Tax Return. 
There are five categories of Capital Allowances. The notepads for all categories are 
similar, but there are variations for each category. In each category you can enter 
data and compute capital allowances and balancing charges or allowances for up to 
50 assets or pools of assets. We begin with a description of the general features of 
the Capital Allowances notepads, followed by descriptions of features specific to 
each category. 
 
Before going into any of the Capital Allowances notepads, make sure you have 
entered the start and end dates of the accounting period on the appropriate form. 
The notepad is in the form of a spreadsheet with a single column for each asset or 
pool of assets and a row for each data item and calculated amount. Five asset 
columns are shown at any one time. If you require more columns, use the Previous 
and Next buttons to view each block of five assets. The currently displayed block 
number (0-9) is shown in the green box between the Previous and Next buttons. All 
data you enter and calculated amounts are rounded to the nearest pound. When the 
accounting period is not 12 months, all calculated amounts are proportioned 
according to the number of months in the accounting period, rounded to the nearest 
integral number of months. 
 
Enter a descriptive name for each asset or pool of assets at the top of each column, 
and then enter applicable values for Private use factor (%), Writing-down factor (%) 
and WDV brought forward. If there were any new or additional purchases during the 
year, enter the amount in one of the Additions box. If a single asset was sold during 
the accounting period, enter the amount in the Sales (individual) box. If part of a 
pool of assets was sold during the accounting period, enter the amount in the Sales 
(pooled) box. You cannot make entries in both the Sales (individual) and Sales 
(pooled) in any one column. As you enter data, the calculated amounts are 
automatically updated in the blue boxes in that column and the totals for all assets 
are updated in the yellow boxes. If, in exceptional circumstances, you wish to 
override the calculated amounts in any column, tick the Calculation override check 
box in that column. All boxes in that column become white and you can then enter 
amounts in any of these boxes. No automatic calculations will be performed in that 
column. 
 
When you have completed all data entry, click on the OK button to store the data 
and copy the total amounts of capital allowances and balancing charges to the Tax 
Return form or supplement. Click on the Cancel button to return to the form or 
supplement without storing any changes you have made. Use the Delete button with 
care; clicking on it will delete all information in the notepad. If you click on the 
Delete button by mistake, click on the Cancel button and you will be able to return to 
the notepad with the previously stored values intact. After returning to the form or 
supplement, click on the Save button on the toolbar to make sure any information 
you have just entered is saved in the client file. 
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Business Calculator 
The Business Calculator can be accessed from page 4 of a primary Self-Employment 
supplement, or from page 1 of the Partnership supplement. 
 
The Business Calculator includes data from the previous year’s Tax Return, which 
may be required in the calculations for the current year. If you have transferred a file 
from the previous year, the previous year’s accounting periods, basis period and 
profits will have been transferred with the file and will automatically appear in the 
Business Calculator for the current year.  Otherwise, you will need to enter the 
previous year’s data where applicable. 
 
Before going into the Business Calculator in the Self-Employment supplement you 
must enter the accounting period in boxes 8 and 9, the dates of commencement 
and/or  cessation,  if  applicable,  in  boxes 6 and  7,  and  tick  box  10  if  the 
accounting date has changed. You must also complete the accounts boxes on pages 
1, 2 and 3 of the supplement to arrive at the profit or loss in box 72 or 76, and enter 
any overlap profit brought forward, if it has not been transferred from the previous 
year. 
 
If there is more than one accounting period for the current year’s tax return you 
must complete Self-employment supplements for the primary (i.e. later) period and 
for all secondary (i.e.  earlier)  periods  before  going  into  the  Business  Calculator  
on  the primary (i.e. ‘0’) supplement. Refer to Example 2 earlier in this chapter for 
details of how to set up a Tax Return with more than one accounting period. 
 
In the Partnership supplement you may have imported data from the Partnership 
Tax Return, in which case the accounting periods and profits will appear 
automatically in the Business Calculator. If  you have not imported data from the 
Partnership Tax Return  you  will  need  to  enter  the  appropriate  data  directly  into  
the  Business Calculator. 
 
To go into the Business Calculator from the Self-employment supplement, click on 
the calculator icon next to boxes 65 and 66. In the Partnership supplement, click on 
the icon next to boxes 5 and 6. 
 
Enter as much information as you have available into the white boxes to ensure that 
the system is able to perform the calculation. When you edit any of the white boxes, 
the yellow boxes change colour to red to indicate that the calculation needs to be 
updated. Click on the Update button to perform the calculations and update the 
yellow boxes. If the system is unable to perform the calculation because there is 
invalid or insufficient data, an error message is displayed and the yellow boxes are 
not updated.  There  are  some  circumstances  in  which  it  will  not  be  possible  to 
complete the calculation, such as when the accounting period ends after the end of 
the tax year. 
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Click on the OK button to store the data, copy the yellow boxes into the appropriate 
boxes on the supplement and return to the supplement. If the Business Calculator is 
not  able  to  perform  the  calculation  you  will  need  to  calculate  the  basis  
period, adjustment and overlap profit manually and enter them directly into the 
appropriate boxes on the supplement. 
  
 

Importing Accounts 
The Tax  Return  module  has  the  capability  to  import  accounts  data  from  other 
software into the Self-Employment Supplement. A simple method is available to 
copy and paste data from spreadsheets, such as Microsoft Excel. There is also a 
facility to import  data  directly  from  files  created  by  various  accounts  production  
software packages. Effective use of these facilities can save time and provide a more 
accurate transfer of information compared with manually typing the information 
directly on to the on-screen Supplement. 
 
 

Copy and Paste from spreadsheets 
If you prepare accounts on a spreadsheet you will be able to transfer the accounts 
data to  the  Self-employment  Pages  of  the  Tax  Return  and  the  Trading  Pages  of  
the Partnership Tax Return. 
 
Start up both the spreadsheet program and the Tax Return program and open the 
appropriate files in each program. 
 
Within the spreadsheet, you will have to arrange a “table” of two columns in the 
following form: 
 
 

FSE14 150,476 

FSE30  
 

38,582 
 

FSE18  
 

37,188 
 

FSE21  
 

2,472 
 

FSE34  
 

1,000 
 

FSE19  
 

4,000 
 

FSE27  
 

956 

FSE24 1,589 
 

FSE28 3,366 
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The  left  column  contains  a  list  of  all  box  numbers  on  the  Self-employment 
Supplement  (only  a sample is shown above). The right column should contain the 
appropriate formulae to compute the amount to be entered in the corresponding 
Self- employment supplement box, using   other information within the spreadsheet. 
Normally, each amount box in the table will be the sum of amounts from other 
boxes on the spreadsheet. You will probably only need to set up the above table 
once and copy it to the spreadsheets for each client’s accounts. 
 
To transfer the information from the table to the Self-Employment supplement you 
must, firstly, copy the information to the Windows Clipboard.  This is a simple 
process in Windows-based spreadsheet programs. Select the whole of the table by 
dragging the mouse over it, and then use Edit --> Copy to transfer the information to 
the Clipboard. 
 
Now, switch to the Tax Return program and go to page 2 of the Self-employment 
supplement.  Select Import --> Accounts --> Paste to copy all information into the 
correct boxes. 

 
 

File transfer from accounts software 
Most accounts production software now has the capability to produce a text file 
containing data in a suitable format for import into the Self-employment 
supplement. Tax Assistant can import data from such files. 
 
Consult your accounts production software supplier to see if it can produce a 
suitable data file. 
 
To import the accounts data into the Self-employment supplement, go to page 1 of 
the supplement and use Import --> Accounts --> File to open the Accounts File 
Import window. 
 
Enter the full directory path to the data file in the text box or, alternatively, use the 
Browse button to locate the file. Select the appropriate file format from the list of 
options then click on the Import button to transfer the information into the correct 
boxes on the supplement. 
 
 

SNF 
Standard  Name  Format  (SNF)  is  a  standard  format  for  transferring  accounts 
information  between  accounts  production  software  and  tax  return  software.  
The standard defines an interface between programs that is independent of the Tax 
Return box numbers. SNF has been adopted by several of the leading suppliers of 
these packages. The Tax Return and Partnership Tax Return programs support SNF 
using both the Clipboard method and the File method. 
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Consult your accounts production software supplier to determine whether the 
program can export data using SNF. In the Tax Return program, go to page 1 of the 
Self- employment supplement.  To import SNF data via the Clipboard use Import --> 
Accounts --> SNF Paste. To import data via a file use Import --> Accounts --> File and 
select the file type as SNF. 
 
 

File Backup 
If you have ever lost valuable data due to a hard disk failure or accidentally deleted 
files, you will realise how important it is to regularly back up your data. For general 
backup, the best solution is a CD/DVD writer, tape backup unit or other mass storage 
device in combination with an automatic backup program that schedules backup of 
all data on your hard disk on a regular basis (e.g. daily or weekly). This ensures 
minimal loss of data should a catastrophe occur. 
 
The Tax Return program includes a file backup function, which simplifies the process 
of backing up individual client files and provides some additional facilities, such as 
the capability to move files between different client file folders. 
 
In this section we describe the File Backup function and give some examples to 
illustrate its use. Note that the File Backup functions described here are not 
applicable to TaxBase data.  TaxBase includes a Backup function that enables you to 
save your client database file. 
 
Firstly, here are a few definitions: 
 
Client file folder The folder which is specified in the current configuration as that in 

which your client files are stored. 
 

Client file A file which you have created within Tax Assistant residing in the 
client file folder. 

Backup folder Any folder within your system (e.g. on your local hard disk, floppy 
disk or a network server.) in which you wish to store backup or 
archive copies of your client files. 

Backup file A file which you have copied or moved from a client file folder into 
a backup folder. 

 
 
Open the File Backup window by selecting File --> Backup. This window has the 
following components: 
 
Client Files list List of file names in the client file folder. 

Backup button  Initiates copying of a client file from the client file folder to the 
backup folder. 

Restore button Initiates copying of a backup file from the backup folder to the 
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client file folder. 

Search buttons Buttons labelled with the letters of the alphabet, which are 
used to rapidly locate file names within the Client Files list and 
the Backup Files list. 

File Name box Used to edit the name of a file being copied between the 
client file folder and the backup file folder. 

Drive list List of all available disk drives. 

Folders list List of all available folders within the currently selected drive. 

Close button Closes the File Backup window. 

Help button Displays Help for the File Backup window. 
 
 

Backing up a client file 
Use the following procedure to copy a client file from the client file folder to a backup 
folder. 
 

1) Click on the list control box at the right of the Drives list to display all 
available drives. 

 
2) In the Drives list, select the drive you wish to use to store the backup file. 

 
3) In the Folders list, select the folder you wish to use to store the backup file. If 

necessary, double click on a folder icon to view its sub-folders and use the 
vertical scroll bar to view all available folders. When you select a backup 
folder, the Backup Files list shows all backup files that are currently stored in 
this backup folder. The Backup Files list will be blank until you have copied at 
least one client file into it. Only those files of the correct type will appear in 
the Backup Files list. For example, if you are currently running the 2011 Tax 
Return program, only 2011 Tax Return backup files will appear in the Backup 
Files list, even if there are backup files in this folder which have been placed 
there by other Tax Assistant programs. 

 
4) In the Client Files list, select the file you wish to copy to the backup folder. 

When you do this, the Backup command button is enabled and the name of 
the file you have selected appears in the File Name text box. The title of this 
box has now changed to ‘Backup File As...’ 

 
5) You will normally not require this step but, if you wish to use a different 

name for the selected client file when it is copied into the backup folder, edit 
the name in the Backup File As... box.  Note that, if you change this name, it 
will not change the file name as it appears in the Client File list, only as it will 
appear in the Backup Files list. 

 



www.drummohr.com 

Getting Started With Tax Assistant 
 

461 

Drummohr is a trading name of Drummohr Technology Ltd which is part of the IRIS Group.  
Drummohr, IRIS and IRIS Flower are trademarks. © Drummohr Technology Ltd 2009. All rights reserved. 

www.drummohr.com 

6) Click on the Backup button to copy the client file to the backup folder. If a file 
with exactly the same name already exists in the backup folder you will be 
given the opportunity to abandon the backup operation before overwriting 
that file. You now have a backup file in the backup folder, which is an exact 
copy of the selected client file. 

 
 

Restoring a client file 
Use the following procedure to copy a backup file from a backup folder to the client 
file folder. 
 

1) Click on the list control box at the right of the Drives list to display all 
available drives. 

 
2) In the Drives list, select the drive from which you wish to retrieve the backup 

file. 
  

3) In the Folders list, select the folder from which you wish to retrieve the 
backup file. If necessary, double click on a folder icon to view its sub-folders 
and use the vertical scroll bar to view all available folders. When you select a 
backup folder, the Backup Files list shows the backup files currently stored in 
this backup folder. Only those files of the correct type appear in the Backup 
Files list. For example, if you are currently running the 2011 Partnership Tax 
Return program, only 2011 Partnership Tax Return backup files appear in the 
Backup Files list, even if there are backup files in this folder which have been 
placed there by other Tax Assistant programs. 

 
4) In the Backup Files list, select the file you wish to copy from the backup 

folder. When you do this, note that the Restore command button is enabled 
and the name of the file you have selected appears in the File Name box. The 
title of this box has now changed to ‘Restore File As...’. 

 
5) You will normally not require this step but, if you wish to use a different 

name for the selected backup file when it is copied into the client file folder, 
edit the name in the Restore File As... box. Note that, if you change this 
name, it will not change the file name as it appears in the Backup Files list, 
only as it will appear in the Client Files list. 

 
6) Click on the Restore button to copy the backup file to the client file folder. If a 

file with exactly the same name already exists in the client file folder you will 
be given the opportunity to abandon the restore operation before 
overwriting that file. You have now restored a backup file from the backup 
folder into the client file folder and you may use it in the same way as any 
other client file. 
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Drag and Drop 
You can use ‘drag and drop’ to move or copy client files. When you move a file it is 
deposited in a new folder and deleted from its original folder. Before you use drag 
and drop make sure you understand exactly what you are doing otherwise you could 
lose files.  They  will  not  be  deleted  from  your  system  but  you  may  have  some 
difficulty finding them later if you accidentally move  them into the wrong folder. 
Practice with some “dummy” files before using real ones. 
 
Use steps (1) - (3) in Backing up a client file above, to select the backup folder. Select 
a client file from the Client Files list. With the mouse pointer over the selected file 
name, hold down the left mouse button. The mouse pointer icon changes to a “drag” 
icon. Still holding down the left mouse button, drag the mouse pointer across the 
screen until it is over the Backup Files list. The mouse pointer icon changes to a 
“drop” icon. Release the left mouse button. A warning message appears giving you 
the opportunity to abandon the move operation. If you confirm that you wish to 
move the file but a file with the same name already exists in the backup folder, you 
are given another opportunity to abandon the move. If you confirm that you wish to 
overwrite the existing file, the client file you selected is moved to the backup folder. 
The file name appears in the Backup Files list and disappears from the Client Files list. 
 
To move a file from the backup folder to the client file folder, use the reverse 
procedure. Select a file in the Backup Files list, then drag and drop it on to the Client 
Files list. Again, warning messages appear to allow you to abandon the operation. 
  
 

Examples 
There are a variety of uses for the File Backup function. The following are typical 
examples. 
 
 

Example 1 
Having completed John Smith’s 2011 Tax Return on your computer at home, you 
wish to make a backup copy of his tax return file, called “Smith, J. B.”, on to a USB 
memory stick. You also want to copy the file on to the computer in your office so 
that you can print out his tax return on your office printer. 
 
On your home computer: 

1) Run the 2011 Tax Return program and open the File Backup window.  
2) Insert a memory stick into a USB port. 
3) Select the memory stick in the Drives list.  
4) Select “Smith, J. B.” in the Client Files list. 
5) Click on the Backup button. 
6) John  Smith’s  file  is  copied  to  the  memory stick  along  with  the  

formatting information  required to restore it to any computer running the 
Tax Assistant software. 
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On your office computer: 

1) Run the 2011 Tax Return program and open the File Backup window.  
2) Insert the memory stick containing John Smith’s file into a USB port. 
3)  Select the memory stick in the Drives list. 
4) Select “Smith, J. B.” in the Backup Files list.  
5) Click on the Restore button. 
6) John Smith’s file is copied from the memory stick into your client file folder. 
7) Close the Backup window, open the file “Smith, J. B.”, open the Reports 

window and print John Smith’s tax return. 
 
 

Example 2 
You have created an individual folder on your c: drive for each of your clients and 
keep a copy of any documents relating to a client in his or her folder. The folder for 
John Smith is called ‘SmithJB’.  Having completed John Smith’s 2011 Tax Return, you 
wish to place a copy of his tax return file, called “Smith, J. B.”, in his folder. 

1) Run the 2011 Tax Return program and open the File Backup window. Select 
drive c:\ in the Drives list. 

2) Select folder c:\SmithJB\ in the Folders list. 
3) Select “Smith, J. B.” in the Client Files list. Drag and drop the selected file on 

to the Backup Files list. 
4) John Smith’s 2011 Tax Return file is copied to his folder. 

  
 

Example 3 

You have, in error, created three new client files in the default folder “C:\Program 
Files\Tax Assistant\Tax11” on your local hard drive instead of in the tax data folder 
“F:\TaxData\Tax11” on your network server. You need to move these three files into 
the correct place. 

1) Use the Windows File Manager or Windows Explorer to create a temporary 
folder, “C:\Temp” 

2) Run the 2011 Tax Return program. 
3) Select the default Client File Folder “C:\Program Files\Tax Assistant\Tax11”. 
4) Open the File Backup window. 
5) Select drive C: in the Drives list and folder “C:\Temp” in the Folders list. 
6) Drag and drop each of the three files from the Client Files list to the Backup 

Files list. 
7) Close the Backup window. 
8) Select the Client File Folder “F:\TaxData\Tax11”. Open the File Backup 

window. 
9) Select drive C: in the Drives list and folder “C:\Temp” in the Folders list. 
10) Drag and drop each of the three files from the Backup Files list to the Client 

Files list. 
11) Close the Backup window. 
12) You can now use these three files in the normal way on the network server.  
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In this example the folder “C:\Temp” has been used as a “mailbox” to move the 
three files from one folder to another within the network. 

  
 

Print Settings 
You may need to make some adjustments to your print settings to obtain optimum 
print performance when printing the substitute Tax Return. You should familiarise 
yourself with the process of setting up your printer within the Windows 
environment. You will usually be able to improve the speed of printing by 
experimenting with the graphics quality in your printer settings. It should not be 
necessary to use a print resolution greater than 300 dpi to give adequate print 
quality in the Tax Return printouts. 
 
Within the Tax Return programs themselves you may find that turning off 
background shading gives a significant improvement in printing performance. Use of 
shading is not mandatory.  The Tax Assistant substitute forms are approved by the 
HMRC, both with and without background shading. 
 
You may find it necessary to make some minor adjustments within the Tax Return 
program to make the printed reports compatible with your printer. The Tax Return 
program contains a Print Settings dialogue box, which allows you to change some of 
the print settings. Click on the Settings button in the Tax Return Reports window to 
open the Print Settings dialogue. The following is a description of the items in this 
dialogue. 
 
 

Printed Page 
Left Offset,  Top  Offset,  Page  Width,  Page  Height  -  These  items  (specified  in 
millimetres) allow you to vary the size and position of the printed output to that 
most suited to your printer. Start with the default settings and make small changes, 
if necessary, to ensure that the Tax Return printouts fill the maximum amount of the 
page and are centred within the page. 
 
Scale (%) - Use this item in conjunction with the offsets and page sizes described 
above to scale the printed page to that most suited to your printer. 
 
Text spacing – On some printers, the printing system used in Tax Assistant may 
distort lines of text that include different font styles (e.g. mixtures of regular, bold 
and italic text).  This  type  of  text  occurs  in  various  places  in  the  Tax  Return  and 
supplement printouts. This distortion takes the form of sections of text being too 
close together or, in extreme cases, overlapping. This effect varies from one printer 
to another. To overcome it, the text spacing value, used in conjunction with the 
‘Enable mixed fonts’ check box (see below) can be varied to overcome this problem. 
A value between 20 and 50 is usually suitable, but you will need to experiment to 
find the best setting for your printer. 
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Enable mixed fonts – This check box is used to determine whether printed lines on 
the Tax Return and supplements will include mixed font styles (e.g. mixed regular, 
bold and italic text). It is turned on by default. In this state it enables printing of lines 
with mixed fonts. The ‘Text spacing’ value (see above) can be used to avoid 
distortion of printed text containing mixed fonts. You can disable printing mixed 
fonts by turning this check box off. 
 
Zoom - This item sets the initial scaling of the print preview window. The best setting 
will depend on the size and resolution of your monitor. 
 
Shading Intensity - With shading turned on, there are four shades used in the Tax 
Return printouts. You can experiment with the settings for Black, Dark Grey, Light 
Grey and White to find the combination that best suits your printer. 0 is black and 
255 are white. 
 
Font – Select the font in which your entries on the Tax Return, Supplements and 
schedules will be printed. You can choose either Arial or Times New Roman. These 
are both standard Windows True-type fonts. 
 
 

Section Breaks 
For normal operation select the ‘None’ option. In this case all printed output will be 
sent to the printer driver software as a single file. If you select the ‘Document’ option 
each document (e.g. Tax Return, Employment supplement, Foreign supplement) will 
be sent to the printer as a separate file. In some circumstances this may give better 
print performance. Its main use, however, is when using a duplex printer. This mode 
of operation will ensure that the printout of each document begins on a new sheet 
of paper. 
 
 

Preview 
For normal operation select the ‘Normal’ option.  This option allows you to preview 
reports within the Tax Assistant programs. As an alternative, the reports can be 
saved as files that may be displayed and printed as PDF documents. Select ‘PDF’ to 
do this. Creating a Tax  Assistant report as a PDF document can be useful, for 
example, if you wish to send the Tax Return printout by electronic means (e.g. by 
email) to a client who has a computer system with a PDF reader like Adobe (but not 
Tax Assistant). 
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Partnership Tax Return 
Operation of the Partnership Tax Return program is similar to that of the Individual 
Tax Return program, but there are some differences. This chapter will take you 
through  the  procedure  of  completing  a  Partnership  Tax  Return  and  transferring 
information  from  a  Partnership  Tax  Return  into  a  Partnership  Supplement  in  a 
personal Tax Return. The procedure will be illustrated by means of an example, 
typical of many of the partnerships with which you will be dealing. If you wish, you 
may  substitute  one  of  your  own  real  partnerships  for  our  example  as  you  
work through the procedure. Read the Tax Return chapter of this booklet before 
reading this chapter. 
 
 
 

The Partnership 
Our example is a partnership of three people who run a gardening business called 
“The Flowerpot Men”. The partners are Mr. A. Bill who owns 50% of the business, 
Mr. B. Ben who owns 25% of the business and Miss C. Weed who also owns 25% of 
the business. Follow the steps below to complete the Partnership Tax Return for The 
Flowerpot Men and the personal Tax Returns for Mr. A. Bill, Mr. B. Ben and Miss C. 
Weed. 
 
 
 

Set up TaxBase data 
As with the personal Tax Return program, you can use the Partnership Tax Return 
program without accessing data from TaxBase. However, most Tax Assistant users 
begin by storing their client data in a TaxBase database. If you want to do this, create 
new TaxBase records for Mr. A. Bill, Mr. B. Ben and Miss C. Weed. In this example, 
you do not need to create full records for each client. You should, however, include 
the  client’s  address  in  the  Personal  section,  the  Tax  Reference  (10-digit  UTR), 
National Insurance number and Tax Office in the Administration section, and the 
business  name  and  description  in  the  Business  section.  You should also select 
‘Partnership’ as the type of business. 
 
You may also create a database record for the partnership. If you do so, enter the 
address for correspondence in the Personal section, the Tax Reference (10-digit UTR) 
and Tax Office in the Administration section and the business name, description and 
commencement and/or cessation dates in the Business section. Also make sure that 
you select ‘Partnership’ as the type of business. 
 
Tip: When creating a new database record for a partnership, use a space as the ‘First 
Name’ and the business name as the ‘Last Name’. 
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Create the Partnership Tax Return 
Start the Partnership Tax Return program. Click on the New File button on the 
toolbar to open the New File window. Select the option to include data from a 
TaxBase database. Enter the name of the file, The Flowerpot Men in the New File 
Name box, and click on the OK button. You are returned to page 1 of the Partnership 
Tax Return and the Import TaxBase data window is opened.  Double-click on ‘The 
Flowerpot Men’ on the client list to import the data from TaxBase into the return. 
 
 

Create the Supplements 
Click on the Supplement Manager button on the toolbar to open the Supplement 
Manager window. You will see that there is already a Supplement called ‘Trading’ in 
the   list.   This   is   not   a   real   supplement;   it   refers   to   the TRADING AND 
PROFESSIONAL INCOME section on pages 2-5 of the main Partnership Tax Return 
form. If you have more than one accounting period for the business you can create 
additional trading supplements by selecting the ‘Trading’ item in the Supplements 
list and clicking on the Copy button. This is exactly the same as creating copies of the 
Self-employment supplement in the Individual Tax Return program. 
 
The Supplement Manager is also used to create the Statement pages (i.e. page 7) for 
each partner. Click on the New button and enter “A. Bill” as the supplement name. 
Select PARTNER as the Supplement Type. Click on the OK button to create the 
supplement for A. Bill. Repeat this process to create supplements for B. Ben and C. 
Weed. 
 
 

Complete the Partnership Tax Return 
You can now complete the Partnership Tax Return in the same way as you 
completed the personal Tax Returns.  You can create supplements as required and 
use the notepads in the Tax Return, Property, Savings, Foreign and disposals 
supplement to enter details of capital allowances, income from property savings 
income, disposals and Foreign income. If you are on page 4 of the main Tax Return or 
page 2 of a Trading supplement you can import accounts data from accounts 
production software or from a spreadsheet. Refer to the Tax Return chapter of this 
guide for details of all these facilities. 
 
 

Import individual partner details 
When you have filled in any required supplements and completed pages 1 to 5 of the 
Partnership Tax Return go to page 6, which is the Partnership Statement. The 
amounts to be allocated are shown in the left column; these are calculated 
automatically by the program from the entries you make on the return. The right 
column contains boxes in which you enter the partner details and the allocated 
amounts for each partner. In the tax form printout, which you will send to the 
HMRC, copies of page 7 will be printed, as required, to print statements for all the 



www.drummohr.com 

Getting Started With Tax Assistant 
 

531 

Drummohr is a trading name of Drummohr Technology Ltd which is part of the IRIS Group.  
Drummohr, IRIS and IRIS Flower are trademarks. © Drummohr Technology Ltd 2009. All rights reserved. 

www.drummohr.com 

partners. To simplify viewing of the partnership statement for each partner, page 7 is 
not displayed. Instead, the details and allocations for any selected partner are shown 
on page 6. For your own records, you may also print page 6 with the statement for 
any selected partner. This will also be useful for giving each partner a printed copy of 
his or her own allocation. 
  
Above the individual partner details there is a dropdown list, which allows you to 
select any individual partner. Click on the down arrow at the right of this dropdown 
list to display the list of all partners and click on a partner’s name in the list to select 
the statement for that partner. Begin by selecting partner A. Bill. You could type in all 
the required details for A. Bill, but if you have already stored the details in TaxBase 
you can import these details directly into the Statement. To do this, click on the 
database icon above the box for the partner’s name and address (box 6) to open the 
Import Partner window. Double-click on ‘Bill, A’ in the list to import the information 
into the partner statement. The partner’s name, address, tax reference and National 
Insurance number are automatically placed in the appropriate boxes. 
 
Use the dropdown list to select partner B. Ben, then import that partner’s details. 
Repeat the process for partner C. Weed. 
 
 

Allocate amounts to the partners 
Select partner A. Bill and scroll down to the lower part of page 6 to view the amounts 
to be allocated. There are three ways to enter individual partner allocations. The 
most obvious is to type the amounts directly into the boxes. There are, however, two 
shortcuts available. You can type a percentage into a box or, alternatively, specify 
the proportion  by  typing  a  forward  slash  followed  by  the  appropriate  number.  
For example, Mr. A. Bill is to be allocated half of the profit so you can type 50% or /2 
into the Profit box 11. Similarly, Miss C. Weed is to be allocated a quarter of the 
profit so you can type 25% or /4 into box 11. You can experiment with these three 
optional ways of entering the allocations and select the method that suits you best. 
 
At any time, you can view the unallocated amounts by clicking on the pointer icon, 
which appears when you move the mouse over the text “Click here to view the 
unallocated amounts” above the item descriptions.  When you have allocated the 
amounts to all the partners you may find there is a few pence difference between a 
total amount and the allocated amount. By viewing the unallocated amounts you can 
make minor adjustments in individual partners’ allocations to make sure the total 
amounts and the allocated amounts are exactly balanced. 
 
Note that there are separate statements for each Trading supplement. If a 
partnership carries on more than one trade or has more than one accounting period 
reported in the Partnership Tax Return, you must create separate copies of pages 6 
and 7 for each trade and/or accounting period.  There  is  a  page  “S”  at  the  end  of  
a  Trading supplement to cope with this. This page can be treated in the same way as 
page 6 of the main Partnership Tax Return form. 
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Print the Partnership Tax Return 
Select Print on the File menu, or click on the Print button on the toolbar to open the 
Reports window. Select the required Tax Return pages, Supplements and schedules 
and click on the Preview button to print the Partnership Tax Return, Supplements 
and supporting schedules. You may need to click on the Settings button and adjust 
some of the print settings to suit your printer.  These   adjustments must be made 
independently from those used for the individual Tax Return. Refer to the Tax Return 
chapter of this booklet for details of the print settings. 
 
 

Import partnership allocations to the Partnership 
Supplement 
Having completed the Partnership Tax Return for The Flowerpot Men, you will now 
want  to  transfer  the  appropriate  information  from  the  partnership  return  to  
the personal Tax Returns for  each of the partners. It is important that you close the 
partnership file before attempting to import data into the partners’ individual Tax 
Returns otherwise you will get a “file in use” error message. 
 
Start the Tax Return program and create three files for Mr. A. Bill, Mr. B. Ben and 
Miss C. Weed. If you have created TaxBase database records for these clients you 
can use the Import function to set up the basic information and create the 
Partnership Supplements. Refer to the Tax Return chapter of this booklet for details 
on creating and completing personal Tax Returns. 
 
Open Mr. A. Bill’s file. 
 
Tip: When you click on the File menu the names of the four most recent files are 
displayed at the bottom of the menu. Click on any one of these names to open that 
file immediately. 
 
Open the Partnership Supplement. Select Partnership on the Import menu to open 
the Import Partnership Allocation window. There are three lists; Partnership Tax 
Return files, Trades, and Partners. Initially, the Trades list and the Partners list are 
blank. Click on ‘The Flowerpot Men’ in the Partnership Tax Returns list and the 
names of the trades and partners appear in the Trades and Partners lists. Click on 
‘Trading’ in the Trades list then click on A. Bill in the Partners list to select the 
statement for A.  Bill for the main partnership trade. Click on the OK button to 
transfer the relevant information from the Partnership Tax Return to the Partnership 
Supplement of Mr. A. Bill’s Individual Tax Return. 
 
Repeat the process for the individual Tax Returns for Mr. B. Ben and Miss C. Weed.  
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You can perform business calculations using the calculator icon adjacent to boxes 5 
and 6 in the same way as you used the business calculator in the Self-employment 
supplement in Example 2 in the Tax Return chapter of this guide. 


